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ABSTRACT
This research included shipping demand modeling, infrastructure asset mapping, and
impacts of Carbon Dioxide (CO2) emission. The current volume of imports and exports was
reviewed for U.S. ports in the East Coast, Gulf Coast, and West Coast regions. The import and
export of goods is a major part of the U.S. economy, and the volume of cargo handled by U.S.
ports is expected to increase in the future as population increases. The major motivation for this
thesis was the need for U.S. ports to make plans now to accommodate this expected growth in
volume. Ports distribute commodities throughout the U.S., and every state would be adversely
affected if improvements are not made to the capacity and infrastructure of U.S. ports. The goals
were to: identify an efficient tool for assisting with the analysis of a port’s current infrastructure
to help with planning for future needs, use a tool to assist with developing alternative shipping
routes as needed, and to analyze intermodal integration scenarios to reduce the amount of CO2
emissions resulting from the rising volume of shipping. The primary objectives were to: (1)
review cargo shipping demand for Twenty Foot Equivalent Unit (TEU) data at selected larger
ports in the U.S. and distribution to states, develop statistical demand models, and predict the
TEU demand data for future 5, 10, 15, and 20 years, (2) create spatial maps of infrastructure and
landuse planimetrics of Landsat-8 satellite imagery scenes for selected sites, (3) evaluate the
accuracy and efficiency of the calibrated Built-Up Area and Natural Surfaces (BANS)
classification of infrastructure features and landuse, (4) estimate cargo shipping volumes using
Automatic Identification System (AIS) for selected shipping routes and calculate related CO2
emissions and their impacts. Case studies involving spatial mapping of selected sites and a

ii

comparison of the planimetrics and calibrated BANS classification were used to determine an
efficient method for mapping the assets of a port’s existing infrastructure and landuse. The AIS
data for selected shipping routes were used through ship counts over a 24-hour period to analyze
this data for mapping shipping routes. Geospatial analysis was also performed using a sample
shipping route to calculate the amount of CO2 emitted by a cargo vessel and to make
recommendations for the reduction of these emissions. The spatial mapping case studies
conducted for the selected areas of the ports of Los Angeles and Long Beach, the Port of
Gulfport, and Oxford, MS showed that the calibrated surface classification using multispectral
satellite imagery would be more efficient than the manual planimetrics for mapping current
infrastructure features and landuse. Global shipping is a major contributor to CO2 emissions.
This is illustrated by a case study for calculating 5,174 tons of CO2 emissions for a cargo vessel
traveling from New York to France. Bigger vessels help to reduce the global CO2 concentration.
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CHAPTER I
INTRODUCTION
1.1

Background and Motivation
According to the American Association of Port Authorities (AAPA), public ports create

many jobs and enhance local and regional economic growth [1]. The annual impact of the U.S.
port industry according to the AAPA includes [1]:


“13.3 million jobs, accounting for $649 billion in personal income and more than
$3.15 trillion in marine cargo-related spending [2];



Some $3.95 trillion in international trade for an all-encompassing range of goods and
services, with nearly 1.4 billion tons, valued at $1.4 trillion, in waterborne imports
and exports alone [3];



More than 1 billion tons of domestic goods moved via water in the U.S. [4];



More than $23.2 billion in U.S. Customs duty revenues in fiscal 2007, representing
70 percent of all Customs duties collected [5].”

As this data indicates, port infrastructure is obviously an important issue. According to
the AAPA, U.S. ports have invested more than $34 billion since 1945, including nearly $9
billion in the last five years alone, to improve U.S. port facilities nationwide [1]. These numbers
are expected to increase in the coming years [1].
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Although large amounts have been spent on port infrastructure over the years, ports must
continue to be maintained and improved. According to the AAPA, some of the most pressing
issues currently facing the U.S. port system are [1]:


Port security



Navigation maintenance and new construction



Freight congestion/intermodal road/rail access



Marine facility expansion and modernization



Coastal environmental protection



The ability to secure funding and financing



Competitiveness and diversified revenue sources



Land acquisition and site development

Many steps are already being taken to address these issues, but these matters will not be resolved
overnight. According to the AAPA, these issues could take over “50 years” to be solved [1].
Port security has been one of the main issues facing the U.S. port system since the 2001
terrorist attacks [1]. To prevent attacks on U.S. ports, hundreds of millions of dollars have been
invested into facility security enhancements, while the federal government has invested
approximately $1.5 billion to enhance security [1].
Emissions are another significant factor facing the U.S. and the world. Figure 1 shows
emission rates for different modes of freight shipping [6]. According to this figure, ships emit
only 10 grams of carbon dioxide (CO2)to carry 1 ton of cargo 1 kilometer, which is much lower
than the 21 grams by trains, 59 grams by trucks, and 470 grams by aircraft. This indicates that
the choice of mode of transportation plays an important role in reducing the amount of CO2 and
other greenhouse gases.
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Figure 1. Grams of carbon dioxide for various modes of transportation
According to a report by the AAPA [1], “Ports handle a variety of cargoes, including
bulk, or loose, cargo; breakbulk cargo in packages such as bundles, crates, barrels and pallets;
liquid bulk cargo like petroleum; dry bulk such as grain; and general cargo in steel boxes called
containers, which are measured in 20-foot equivalent units, or TEUs.” The most commonlyshipped commodities for domestic and foreign trade in U.S. ports include [1]:


Crude petroleum and petroleum products, including oil and gasoline



Chemicals and related products, such as fertilizer



Bituminous, metallurgical and steam coal



Food and farm products, including wheat and wheat flour, corn, soybeans, rice, and
cotton
3



Forest products, such as lumber and wood chips



Iron and steel



Soil, sand, gravel, rock, and stone



Automobiles, auto parts, and machinery



Clothing, shoes, electronics, and toys

U.S. ports handle a large volume of imported and exported goods, which are distributed
throughout the U.S. and around the world. It is clear that maintaining and improving the
infrastructure, emissions, and security with regard to U.S. ports and shipping will be increasingly
important in the years to come.
The motivation for this research is primarily the Intermodal Optimization for
Economically Viable Integration of Surface and Waterborne Freight Transport project being
conducted by the Center for Advanced Infrastructure Technology (CAIT), as a part of the
National Center for Intermodal Transportation for Economic Competitiveness (NCITEC) grant at
the University of Mississippi [7].
1.2

Objectives and Scope
The primary objectives for this thesis were to:
1. Review cargo shipping demand for TEU data at selected larger ports in the U.S. and
distribution to states, develop statistical demand models, and predict the TEU demand
data for future 5, 10, 15, and 20 years.
2. Create spatial maps of infrastructure and landuse planimetrics of Landsat-8 satellite
imagery scenes for selected sites.
3. Evaluate the accuracy and efficiency of the calibrated Built-Up Area and Natural
Surfaces (BANS) classification of infrastructure features and landuse.
4

4. Estimate cargo shipping volumes using AIS for selected shipping routes and calculate
related CO2 emissions and their impacts.
This thesis evaluates cargo demand at the study area of the ports of Los Angeles and
Long Beach. The study includes cargo import and export data for major U.S. ports, including the
study area. An optimization analysis is made for freight shipment from the study area to
destinations in selected states.
This thesis will also look at container ship TEU prediction modeling for selected ports.
Regression and AutoRegressive Integrated Moving Average (ARIMA) analysis are made and
compared for TEU demand modeling. Regression equations are used to make prediction for
future years.
Spatial mapping is made of selected areas to determine each areas’ infrastructure and
landuse. A comparison of calibrated BANS classification and planimetrics is made. Surface
temperatures and population densities are also evaluated for selected areas. This thesis also
examines cargo vessel data through Automatic Identification System (AIS) data and spatial
mapping. Shipping emissions data is obtained through the study of a sample cargo vessel trip.
The use of geographical information systems (GIS) for infrastructure inventory and
spatial maps has been shown by Uddin [8]. According to Uddin, Hudson, and Haas [9], “GIS
and geospatial applications will greatly improve with the availability of remote sensing data from
terrestrial, airborne, airborne technologies. It will have a dramatic impact in the coming decade
as more user-friendly and generally applicable systems are developed and implemented.” If GIS
technologies continue to improve in the next decade as is suggested here, U.S. ports could use
these GIS technologies to identify present assets and to assist in maintaining and improving
infrastructure and landuse. U.S. ports will also be able to use these GIS technologies to help
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with port congestion. Port congestion can be helped by these GIS technologies by identifying
new routes for vessels to enter and exit congested ports. GIS technologies will also help with
routes to other ports. Finding faster and more efficient routes can help reduce CO2 emissions
throughout a trip.
1.3

Research Methodology
The research methodology for this thesis is broken into several parts. The research

methodology for the U.S. ports data and for the ports of Los Angeles and Long Beach
distribution data is as follows:


Collect the most current tonnage data of imports and exports for all container liner
service ports in the U.S.



Create maps and graphs of the data obtained.



Collect distribution data for the ports of Los Angeles and Long Beach to each U.S.
state.



Create spatial maps and plots of the distribution data obtained.

The research methodology for the ports of Los Angeles and Long Beach ARIMA
modeling is as follows:


Collect TEU data from 1995-2013 of the ports of Los Angeles and Long Beach.



Collect Gross Domestic Product (GDP) data from 2005-2014 for Los Angeles, CA.



Develop a regression equation using time as the independent variable.



Develop an ARIMA model using time as the independent variable.



Develop a regression equation using GDP as the independent variable.



Compare the models made.
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Make plots of the data found from the ARIMA (1,2,1), regression equation with time
as the independent variable, and regression equation with California GDP as the
independent variable and compare results.



Predict TEU values for 5, 10, 15 and 20 years in the future.

The research methodology for spatial mapping of selected areas and identifying current
infrastructure and landuse of the ports of Los Angeles and Long Beach, the Port of Gulfport, and
Oxford, MS, are as follows:


Create pan-sharpened images of the selected ports and locations.



Develop the planimetrics and calibrated BANS classification for each location.



Compare the results obtained from the planimetrics and calibrated BANS
classification.



Compare the findings for each location to each other.

The research methodology for the AIS data, vessel shipping emissions, and ports
environmental impacts are as follows:


Collect cargo vessel count data for selected areas.



Create plots of cargo vessel data for all study areas analyzed.



Examine the environmental impacts of shipping by calculating shipping-related CO2
emissions data using a sample cargo vessel trip.
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CHAPTER II
CARGO DEMAND AT THE PORTS OF LOS ANGELES AND LONG BEACH
AND DISTRIBUTION BY STATE
The ports of Los Angeles and Long Beach are areas of focus in this thesis. These ports
handle a significant amount of the total U.S. container liner service freight and have a large
impact on the U.S. The motivation behind choosing these two ports was to perform a study on
larger U.S. ports with little known research already done.
2.1

Cargo Import and Export Demands at Major Ports in the U.S.
Container liner service ports in the U.S. are a main focus of this thesis. These ports

handle most of the goods that are imported to and exported from the U.S. by way of waterway
shipping. Figure 2 shows all the U.S. container liner service ports [10].

Figure 2. All U.S. container liner service ports
8

As shown in Figure 2, container liner service ports in the U.S. may be divided into three
different regional locations: the West Coast, the East Coast, and the Gulf Coast. Based on 2010
data, California handled the most total freight in the West Coast region at over 90 million short
tons. On the Gulf Coast, Texas and Louisiana both handled over 90 million total short tons of
freight. On the East Coast, six states each handled over 30 million short tons of total freight [10].
Although the East Coast does not have a port as large as the West Coast or the Gulf Coast, this
region has the most container liner service ports with 25. The West Coast has 23 container liner
service ports, and the Gulf Coast has only 7 container liner service ports. The imports and
exports tonnage for each region will be discussed in this thesis.
2.1.1

U.S. West Coast States Container Liner Service Port Freight Data
Data for the U.S. West Coast container liner service ports was obtained and broken down

for each state on the U.S. West Coast that had a container liner service port. Figure 3 shows the
percentage of imported freight that each of the West Coast states accounted for in 2010. The
imports accounted for 49% of the total U.S. West Coast freight. As can be seen from Figure 3,
California accounted for 74.50% of the entire West Coast imports.

Figure 3. Imports for the U.S. West Coast container liner service ports
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Figure 4 shows the percentage of exported freight that each of the West Coast states
accounted for in 2010. The exports accounted for 51% of the total U.S. West Coast freight.
California again led the way in the West Coast region with 53.13% of the total exports.

Figure 4. Exports for the U.S. West Coast container liner service ports
Figure 5 shows the total freight from container liner service ports in each West Coast
state and the percentage of the total freight each state accounted for in 2010. As shown in Figure
5, California had the most total freight with 137.3 million short tons, or 63.13% of the total U.S.
West Coast freight. Washington accounted for 21.1%, Oregon 8.6%, Hawaii 3.8%, and Alaska
2.8%. California and Washington accounted for the majority of the U.S. West Coast total
freight. Figure 6 shows the total freight for the U.S. West Coast container liner service ports and
shows the number of ports in each state. Alaska has 9 ports, California 5, Washington 4, Hawaii
4, and Oregon 1. The ports of Los Angeles and Long Beach accounted for 119 million short tons
or 55% of the total West Coast freight. These ports will be discussed in more depth throughout
this thesis.
10

Figure 5. Total freight from U.S. West Coast container liner service ports

Figure 6. Total freight from U.S. West Coast container liner service ports with number of
container liner service ports in each state
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2.1.2

U.S. Gulf Coast States Container Liner Service Port Freight Data
Data for the U.S. Gulf Coast container liner service ports was obtained and broken down

for every state on the U.S. Gulf Coast that had a container liner service port. Figure 7 shows the
percentage of imported freight that each of the Gulf Coast states accounted for in 2010. The
imports accounted for 49% of the total U.S. Gulf Coast freight. As can be seen from Figure 7,
Texas accounted for 71.47% of the entire Gulf Coast imports.

Figure 7. Imports for the U.S. Gulf Coast container liner service ports
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Figure 8 shows the percentage of exported freight that each of the Gulf Coast states
accounted for in 2010. The exports accounted for 51% of the total U.S. Gulf Coast freight.
Texas again led the way with 49.13% of the total Gulf Coast exports.

Figure 8. Exports for the U.S. Gulf Coast container liner service ports
Figure 9 shows the total freight from container liner service ports in each Gulf Coast state
and the percentage of the total freight each state accounted for in 2010. As shown in Figure 9,
Texas had the most total freight with 193.3 million short tons or 63.13% of the total U.S. Gulf
Coast freight. Louisiana accounted for 30.01%, Alabama 9.24%, and Mississippi 0.67%. Texas
and Louisiana accounted for the majority of the U.S. Gulf Coast total freight. Figure 10 shows
the total freight for the U.S. Gulf Coast container liner service ports and the number of ports in
each state. Texas had 4 ports, Louisiana 1, Alabama 1, and Mississippi 1.
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Figure 9. Total freight from U.S. Gulf Coast container liner service ports

Figure 10. Total freight from U.S. Gulf Coast container liner service ports with number of
container liner service ports in each state
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2.1.3

U.S. East Coast States Container Liner Service Port Freight Data
Data for the U.S. East Coast container liner service ports was obtained and broken down

for every state on the U.S. East Coast that had a container liner service port. Figure 11 shows the
percentage of imported freight that each of the East Coast states accounted for in 2010. The
imports accounted for 64% of the total U.S. East Coast freight. As can be seen from Figure 11,
the East Coast had two states that handled almost half of its imports, with New Jersey at 22.86%
and Pennsylvania at 22.72%.

Figure 11. Imports for the U.S. East Coast container liner service ports
Figure 12 shows the percentages of exported freight that each of the East Coast states
accounted for in 2010. The exports accounted for 36% of the total U.S. East Coast freight. For
the U.S. East Coast, Virginia led the way with 32.86% of the total exports.
15

Figure 12. Exports for the U.S. East Coast container liner service ports
Figure 13 shows the total freight from container liner service ports in each East Coast
state and the percentage of the total freight each state accounted for in 2010. As shown in Figure
13, New Jersey had the most total freight with 57.92 million short tons or 16.3% of the total U.S.
East Coast freight. Of the 15 U.S. East Coast states that had container liner service ports, 6 of
these states accounted for 9% or more of the U.S. East Coast total freight. Figure 14 shows the
total freight for the U.S. East Coast container liner service ports and the number of ports in each
state. Florida had 7 ports, Virginia 3, Pennsylvania 2, Maine 2, and the remaining states contain
1 port each.
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Figure 13. Total freight from U.S. East Coast container liner service ports

Figure 14. Total freight from U.S. East Coast container liner service ports with number of
container liner service ports in each state
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2.1.4

Comparison of U.S. West, Gulf, and East Coast States Total Freight Data
In this section of the thesis, the three coastal regions in the U.S. with container liner

service ports are compared. Figure 15 shows the total freight for container liner service ports in
the entire U.S. based on 2010 data, including the totals for the West Coast, Gulf Coast, and East
Coast regions. As seen in Figure 15, the East Coast had the largest amount of freight at 355.8
million short tons or 39.83% of the total U.S. freight. The Gulf Coast accounted for 321.7
million short tons or 36.01% of the total U.S. freight, and the West Coast accounted for 215.9
million short tons or 24.17% [10].

Figure 15. Total U.S. container liner service port freight
2.2

Preliminary Cargo Spatial Mapping of Infrastructure Features of the Ports of Los Angeles
and Long Beach
This section shows preliminary mapping of the infrastructure features for the ports of Los

Angeles and Long Beach. Chapter 4 of this thesis will provide a more in-depth view of the
ports’ infrastructures and landuse.
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Figure 16 shows the water and port locations of the ports of Los Angeles and Long
Beach. It is important to note that the ports of Los Angeles and Long Beach are within just a few
feet of one another. The infrastructure and landuse of the ports of Los Angeles and Long Beach
will be further discussed later in this thesis.

Figure 16. Preliminary mapping of the ports of Los Angeles and Long Beach infrastructure
2.3

Import Distribution from the Ports of Los Angeles and Long Beach to U.S. States
This section covers the distribution of imports from the ports of Los Angeles and Long

Beach throughout the U.S. Figure 17 is a map of the West Coast states, showing how many
imports California handled [10]. As can be seen from Figure 17, California handled over 90
million total short tons in 2010. The actual number for California was 137,304,074 short tons.
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Of this 137,304,074, the ports of Los Angeles and Long Beach accounted for 119 million short
tons. Of this 119 million, 70,434,335 short tons were imported and 48,565,665 short tons were
exported [10].

Figure 17. Imported and exported tons of the U.S. West Coast states
The ports of Los Angeles and Long Beach are the two largest ports in terms of import
tonnage on the U.S. West Coast. Commodity flow survey data was obtained to determine where
these ports’ imports are sent [11]. This data shows domestic freight shipments by American
establishments in mining, manufacturing, wholesale, auxiliaries, and selected retail and services
trade industries. The total number of import tons at the ports of Los Angeles and Long Beach to
top five states was 66.76 million tons. To find the ports’ distribution data, the following
percentages of the total freight shipped to the states were assumed: CA (93.63%), AZ (2.15%),
NV (2.14%), TX (1.24%), and WA (0.84%). After this percentage was found, the percentage
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was taken from each state to which Los Angeles and Long Beach distribute to. The data initially
obtained for this topic included import totals that were much larger than expected. It was found
that the imported vessel freight was 19% of the total freight shipped from the Los Angeles and
Long Beach area [10, 11]. After finding 19% of each U.S. state’s imported totals, the total
imported cargo vessel counts were calculated. After these numbers were determined, the total
tonnage distributed per capita for each U.S. state was found [12]. After obtaining this data,
Figures 18, 19, and 20 were created.
Figure 18 shows the top five states to which the ports of Los Angeles and Long Beach
distribute their imports. California retained most of the total imported freight from the ports of
Los Angeles and Long Beach at 62,651,460 tons or 93.63%.

Figure 18. Top five states to which the Ports of Los Angeles and Long Beach sent their imports
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Figure 19 shows the top five tonnage per capita states to which distributions were made
from the ports of Los Angeles and Long Beach. California was the highest with 1.68 tons per
capita and was the only state to be over 1 ton per capita. Other states have a larger percentage
per capita because California’s population is higher. This is why the 61.12% for California is not
higher.

Figure 19. Top five tonnage per capita states to which the ports of Los Angeles and Long Beach
made distributions
Figure 20 is a map of per capita distribution by U.S. state from the ports of Los Angeles
and Long Beach. As shown on the map, the West Coast states had over .01 freight tons per
capita distributed to them, except for Alaska.
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Figure 20. Distribution of imported freight per capita by the ports of Los Angeles and Long
Beach by state
2.4

Optimization Analysis for Freight Shipment from the Ports of Los Angeles and Long
Beach
In this section, the freight shipment was analyzed using linear optimization. Excel Solver

was used to solve a linear optimization problem involving a port that was sending freight
tonnage to five separate state markets. An objective function and constraints were created to
solve the problem. The first step was to determine the shipping distances from the ports of Los
Angeles and Long Beach to the five state markets to which the freight for these ports is
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distributed. The linear distances were determined using Google Earth [27]. Figure 21 illustrates
the coordinates for the ports and the origin and destination points for the linear distances between
the ports and the five selected state market locations.

Figure 21. Linear routes between the ports of Los Angeles and Long Beach
to the five state markets [27]
Table 1. Estimated linear distance between ports of Los Angeles and Long Beach
and five state markets
Ports
State Markets
Distance (Miles)
California, CA
364.0
Arizona, AZ
355.9
Ports of Los Angeles and Long
Nevada, NV
243.6
Beach
Texas, TX
1,241.7
Washington, WA
981.3
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Table 1 shows the linear distance from the ports to all five state markets. The maximum
distance is from the ports to Texas. The minimum distance is from the ports to Nevada, which is
about one-sixth of the distance from the ports to Texas.
The next step was to calculate the total shipping costs based on million tons of freight and
miles traveled. The unit cost per ton-mile used for shipping by rail was 3.70 cents per ton-mile
and 42.38 cents per ton-mile for shipping by truck [13]. Unit cost in U.S. dollars per ton freight
was calculated by dividing cents per ton-mile by 100, and then multiplying this amount by the
distance traveled.
A comparison was made between: 1) the total shipping cost of the freight entirely by
road, and 2) the total shipping cost of the freight transported 70% by road and 30% by rail. The
cents per ton-mile for 70% road and 30% rail was the summation of 0.70 multiplied by 42.38
cents and 0.3 multiplied by 3.70 cents. The result was 30.78 cents per ton-mile or 0.3078 U.S.
dollars per ton-mile. Table 2 and Table 3 show the unit costs per ton transported by road, and
integration between road and rail, respectively.
Table 2. Unit cost in U.S. dollars per ton (100% road) for base scenario
Linear Distance from the Ports to each State Market and Unit Cost per Ton
Distance
(bij)U.S. Dollars Per Ton
Ports (i)
State Markets (j)
(Miles)
Distances x (42.38/100)
California, CA
364.0
$154.24
Arizona, AZ
355.9
$150.81
Ports of Los
Angeles and
Nevada, NV
243.6
$103.22
Long Beach
Texas, TX
1,241.7
$526.24
Washington, WA
981.3
$415.87
The right column in Table 2 shows the cost function bij for base scenario and Table 3
shows bij for the alternative scenario. The Following Equation 1 was used to calculate bij.
bij = (Distance from port to state market x (unit cost/100))
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(1)

Table 3. Unit cost in U.S. dollars per ton (70% road, 30% rail) for alternative scenario
Linear Distance from the Ports to each State Market and Unit Cost per Ton
Distance
(bij)U.S. Dollars Per Ton
Ports (i)
State Markets (j)
(Miles)
Distances x (30.78/100)
California, CA
364.0
$112.02
Arizona,
AZ
355.9
$109.53
Ports of Los
Angeles and
Nevada, NV
243.6
$74.97
Long Beach
Texas, TX
1,241.7
$382.20
Washington, WA
981.3
$302.04
2.4.1

Objective function and formulation of constraint inequalities
Before the analysis was conducted, certain conditions must be met for the objective

function and constraints as shown in Equations 2 through 5 [39]. The formulation of the
objective function to minimize total shipping costs from the selected port to each state is shown
in Equation 2 for the base scenario and alternative scenario cases.
Minimize: Z = ∑

∑

(2)

Z= Total cost (U.S.$) to ship from port (i) to each state market (j), where i=1,…I and j=1,2,3,…J
= Quantity of the freight tonnage shipped from port (i) to state market (j)
= Unit cost per ton-mile for freight shipping from port (i) to state market (j) (distance is dij)
(This basic unit cost for freight truck is 42.38 cents per ton-mile and the freight rail unit cost
is 3.70 cents per ton-mile.)
The next step was to formulate the constraints for this objective function. All constraints
and inequalities must be equal or more than certain values. The first constraint deals with the
summing of all commodity freight shipped from the port location to all state markets, which
cannot exceed the total commodity freight available at the port (Equation 3).
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∑

yij ≥ -T

(3)

Where, T= Total freight available at port, where i=1,…I and j=1,2,3,…J

The second constraint deals with the total amount sent to a state market, which cannot be
less than the amount of the commodity required in that state market as shown in Equation 4.

∑

yij ≥ rj

(4)

rj= Freight required at each port (i) for the state market (j), where i=1,…I and j=1,2,3,…J

Finally, a non-negative constraint was applied to ensure that tonnage values shipped by
each mode always remained positive [39]. The amount of freight from port to state market must
be a positive value as shown in Equation 5.

yij ≥ 0
= Quantity of the freight tonnage shipped from port (i) to state market (j),
where i=1,..I and j=1,2,3,..J

The linear programming optimization was conducted using Excel Solver for the
following scenarios:


Base scenario of freight shipping 100% by road.



Alternative scenario of freight shipping 70% by road and 30% by rail.

The results can be seen in Table 4 and Table 5.
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(5)

Table 4. Optimized minimum transportation costs for freight shipping
100% by road (base scenario)

Base Scenario
(100% Truck)

Ports of Los Angeles and Long Beach
Freight Available: 66.76 million tons
a

b

CA
AZ
Unit Cost Per Ton $154.24 $150.81
Freight Million
62.51
1.44
Tons (Distributed)

Z

c

d

e

NV
$103.22

TX
$526.24

WA
$415.87

1.42

0.83

0.56

(Millions U.S.
Dollars)

$10,675.09

For the base case scenario, the optimized minimum cost is $10,675,090,000. This cost
is based on higher unit costs per ton ranging from $103.22 to $526.24 for specific state markets.
The highest freight tons (62.51 million) were shipped to a market destination in California. The
lowest freight tons were shipped to Washington state, which is approximately less than 1% of
the freight tons shipped within California.
Table 5. Optimized minimum transportation costs for freight shipping
70% by road and 30% by rail (alternative scenario)
Alternative
Scenario
(70 % Truck and
30% Rail)
Unit Cost Per Ton
Freight Million
Tons (Distributed)

Ports of Los Angeles and Long Beach
Freight Available: 66.76 million tons
a

b

c

d

Z
e

(Millions U.S.
Dollars)

CA
AZ
NV
TX
WA
$112.02 $109.53 $74.97 $382.20 $302.04
62.51

1.44

1.42

0.83

0.56

$7,753.16

For the alternative scenario, the optimized minimal cost is $7,753,160,000. This cost
resulted from lower unit costs per ton ranging from $74.97 to $382.20, under the same number of
freight tons as in the base scenario.
It was observed that the optimized shipping cost for the alternative scenario was
$2,921,939,000 lower compared to the base scenario. The decrease in the shipping cost for the
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alternative scenario was 27.4% when 30% of the truck freight was diverted to rail. This linear
optimization analysis shows a reduction in shipping costs as more freight is diverted from road
transportation options to intermodal rail transportation options for the following freight
distributions to the top five selected state markets (Table 6). A detailed step-by-step procedure
conducted for linear optimization analysis is described in Appendix A.
Table 6. Freight distribution (million tons) to state market
Ports Distribution to Each State Market
State Market
California, CA
Arizona, AZ
Nevada, NV
Texas, TX
Washington, WA
Total
2.5

Freight Distribution
(Million Tons)
62.51
1.44
1.42
0.83
0.56
66.76

% Freight
Distributed
93.63%
2.15%
2.14%
1.24%
0.84%
100%

Concluding Remarks
Sea ports in the U.S. play a very important role in the daily lives of every American.

Millions of tons of freight are handled by U.S. ports annually, helping Americans to acquire their
basic needs and other goods. The West Coast is home to two of the top five largest ports in the
U.S. [10]. The two ports, the ports of Los Angeles and Long Beach, are further discussed in this
thesis, including the ports’ tonnage, TEUs, infrastructure, and landuse.
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CHAPTER III
CONTAINER SHIP TEU PREDICTION MODELING FOR SELECTED PORTS
3.1

TEU Data Visualization and ARIMA Modeling for the Ports of Los Angeles and Long
Beach
The ports of Los Angeles and Long Beach in the State of California are located directly

next to each other. Based on demand, vessels can go to the port in Los Angeles or to the port in
Long Beach when they arrive in this area. Knowing this, TEU data for these ports from 19952014 was combined [14]. Figure 22 shows the raw TEU time series data at these ports [14]. The
time series plot shows a significant difference in TEU value in year 2008, which is the year of
the most recent economic recession (ER) in the U.S. Therefore, the two data sets (before and
after 2008) were analyzed for statistically significant difference.

Figure 22. TEU time series data of the ports of Los Angeles and Long Beach
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3.1.1

Setting up a One-Way Analysis of Variance (ANOVA) Hypothesis Test
The following assumptions are made for ANOVA test [15]:
1) Random sampling
2) Normality
3) Equal variances

Step 1 is to conduct an ANOVA hypothesis test of significance; a null and an alternative
hypothesis are made [16].


H0: µ1 = µ2



HA: µ1 ≠ µ2



µ1 = Population mean of annual TEUs before 2008 economic recession



µ2 = Population mean of annual TEUs after 2008 economic recession

Step 2 is to select an alpha value for statistical significance test.


α = .05

Step 3 is to define the critical F and the α/2 level.


df = 227



df between = 1



df within = 226



α/2 = 0.025



FCritical = 5.02 (Found from F-table [8]).

Step 4 is to establish the Decision Rule.


Reject H0 if Ftest ≥ FCritical



44.663 ≥ 5.02

Step 5 is to calculate the Grand Mean.
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XGM = ∑ X / N



XGM = Grand Mean = 952,258.22



N = total sample size



X = total of all data values

Step 6 is to find the total sample variation.


SS (T) = ∑ (x – XGM)2



SS (T) = Total Variation = 1.965 x 1013

Step 7 is to solve the between-group variation.


SS (B) = ∑ n (x – XGM)2



SS (B) = sum of squares between groups = 3.242 x 1012

Step 8 is to find the within-group variation.


SS (W) = ∑ df * s2



SS (W) = sum of squares within group = 1.640 x 1013



df = N-k =229-2 = 227



k = number of samples

Step 9 is to calculate the F test statistic.


Ftest = MSBG / MSWG



Ftest = 44.663

Step 10 is to report the final results.


Ftest (44.663) > Fcritical (5.02)



Therefore, H0 cannot be accepted.

To see the effect of the U.S. economic recession in 2008, a comparison of data before and
after was made using the one-way ANOVA analysis using SPSS [17]. Table 7 shows the SPSS
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output for the ANOVA test. There was a statistically significant difference between the two data
sets and TEU data because Sig. is 0.000 (less than α/2, or 0.025) as shown in the right column of
Table 7.
Table 7. One-Way ANOVA Results

Between
Groups
Within
Groups
Total

3.1.2

Sum of Squares

df

3241717809987.834

1

16403392230991.781

226

19645110040979.613

227

Mean Square

F

3241717809987.834 44.663

Sig.
.000

72581381553.061

Developing Regression Equations for TEUs
Because of the statistically significant difference in post-2008 and prior years TEU data,

a dummy variable for post-economic recession was used to develop a regression equation. Every
month in 2008 and in prior years, the ER_Dummy was assigned 0.00, and every month after the
ER_Dummy was assigned a 1.00 in the dummy variable column. This was done to model the
difference in the TEU data from 1995-2008 and 2009-2014 [17]. Equation 5 was developed
from combined ports of Los Angeles and Long Beach data. The R value for the 1995-2013 ports
of Los Angeles and Long Beach data is 0.95. Figure 23 shows measured vs. predicted data using
Equation 5 on all the TEU data, from 1995 to 2013. The mean absolute relative error (MARE)
and root mean square error (RMSE) were the methods used to compare if each analysis was
acceptable [18, 19]. The equations for the MARE and RMSE can be seen in Equations 6 and 7
[18, 19]. According to these sources, “The MARE is a statistical accuracy measure that is used
to filter out the most promising optimal networks or models. If the value of MARE is small,
close to zero, it means that the model’s performance is good” [18]. The RMSE is generally used
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as a measure of the difference between values predicted by the model and measured values.
RMSE is an indicator of model accuracy or precision. “RMSE should be as low, or as close to
zero, as possible” [19]. Figure 23 shows that the MARE is 7.10% and the RMSE was 92,131.72
for the regression equation 1995-2013 TEU data. Figure 24 shows validation of Equation 5
using 2014 TEU data. The MARE for the measured and predicted 2014 TEU data is 8.78%,
which is reasonable. The RMSE for the data is 127,342.46. Figure 25 shows further validation
of Equation 5 using 1995-2014 TEU data. The RMSE for the data is 115,448.67. The MARE is
9.86%, which is reasonable.
TEU = 308,935.109 + (5,917.916 x Month_R) + (-403,857.290 x ER_Dummy)
∑

100

MARE =

RMSE =

∑

Figure 23. Measured vs. predicted TEUs 1995-2013 (Regression Equation)
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(5)

(6)

(7)

Figure 24. Validation of measured vs. predicted TEUs 2014 (Regression Equation)

Figure 25. Measured vs. predicted TEU data for the regression equation
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ARIMA modeling was performed next due to a high sequential R value of 0.97 for the
TEU data set. This high sequential R means that the regression analysis does not meet the
criterion for no sequential correlation. Therefore, ARIMA modeling was pursued.
3.1.3

ARIMA Modeling of TEU time series
First, several ARIMA models were developed using the procedure described in the book,

Applied Times Series Analysis for the Social Sciences by McCleary and Hay, Jr. in SPSS
software [17, 20]. McCleary and Hay, Jr. [20] discuss in depth the criteria to select the
appropriate (p,d,q) terms in the ARIMA model. In the ARIMA model, p stands for
autoregressive term, d is for series differencing term, and q is for moving average term.
For selecting the (p,d,q) terms to model this TEU data, the Pearson’s correlation table
from Nguyen’s dissertation [21] was created. In this table sequential R, AutoRegression (AR)
lag 1 vs. month, AR lag 2 vs. month, month vs. one differencing, month vs. two month moving
average (MA), and month vs. three month MA will all be found to determine what (p,d,q) to
select. To accomplish this, Excel software was needed. The following steps were used to find
the correct (p,d,q):
Step 1 was to obtain all raw data of monthly TEUs for the ports of Los Angeles and Long Beach
[14].


Obtain raw TEU data for the Port of Los Angeles [14].



Obtain raw TEU data for the Port of Long Beach [14].



Combine the Port of Los Angeles and Port of Long Beach TEU data to get the final
TEU raw monthly data numbers.

Step 2 was to determine which AR or “p” term to use.


Find AR lag 1 vs. month.
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Find AR lag 2 vs. month.



Make a correlation equation between month values and TEU values.



For AR lag 1 TEU values move down one month leaving January 1995 empty.



For AR lag 2 TEU values move down two months leaving January and February 1995
empty.



Select the higher of the two AR values.

In this case, both of the lags had a value of 0.86, and either term would have been
acceptable to select. For this case, lag 1 was selected for AR or “p”. Table 8 shows the AR
values.
Step 3 was to select the differencing term or “d” for the ARIMA model.


Find month vs. differencing term.

To find differencing, a correlation between the month and difference between each
month’s values was made. For differencing 1 the value was skipped so it was the first value
minus the second value. This was repeatedly done until December of 2014. The differencing
term was 1. However, a greater or lesser difference may affect the TEU data. A model with 0
and 2 for differencing was also made. Table 8 shows the “d” or differencing value.
Step 4 was to select the moving average term or “q” for the ARIMA model.


Find month vs. two month MA.



Find month vs. three month MA.



For two month MA take two values and take the average of that.



For three month MA take three values and take the average of that.



Select the higher of the two MA values.
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The MA helps smooth out the curve of the data. In this case, two month MA and three
month MA had the same value. For MA or “q”, 1 was also selected. The value for MA can be
seen in Table 8. Figure 26 also shows the values of AR lag 1, AR lag 2, differencing, two month
MA, and three month MA.
Table 8. Pearson’s correlation table

Figure 26. Values of AR lags, differencing, and MA values
Next, run the final ARIMA (1,1,1), (1,0,1), (1,2,1) to get final results and predict which
will be the best model. Figure 27 shows the results for the final ARIMA (1,1,1). In Figure 27, it
can be seen in the residual autocorrelation function (ACF) and residual partial autocorrelation
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function (PACF) plots that some of the residual numbers go outside of the confidence intervals,
however, the final three residual numbers are very near 0.0. Figure 28 shows a high R value for
1995-2013 predicted vs. measured data with a R=0.97. Figure 29 is validation of the ARIMA
(1,1,1). Figure 29 shows that MARE for the measured and predicted 2014 TEU data for ARIMA
(1,1,1) is 4.89%. ARIMA (1,0,1) was then run to determine if better results could be obtained.

Figure 27. Residual ACF and PACF plot for ARIMA (1,1,1) model equation

Figure 28. Measured vs. predicted TEUs 1995-2013 ARIMA (1,1,1) model equation
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Figure 29. Validation of measured vs. predicted TEUs 2014 ARIMA (1,1,1) model equation
Figure 30 shows the results for the final ARIMA (1,0,1). In Figure 30, it can be seen that
only 4 or 5 residual numbers go outside of the confidence intervals of the residual ACF or
residual PACF plots. Figure 31 shows a high R value for 1995-2013 predicted vs. measured data
with a R=0.97. Figure 32 is validation of the ARIMA (1,0,1). Figure 32 shows that MARE for
the measured and predicted 2014 TEU data for ARIMA (1,0,1) is 7.50%. This is a higher
MARE value between the measured and predicted difference. Therefore, ARIMA (1,2,1) was
then used to determine if better results could be obtained.

Figure 30. Residual ACF and PACF plot for ARIMA (1,0,1) model equation
40

Figure 31. Measured vs. predicted TEUs 1995-2013 ARIMA (1,0,1) model equation

Figure 32. Validation of measured vs. predicted TEUs 2014 ARIMA (1,0,1) model equation
Figure 33 shows the results for the final ARIMA (1,2,1). In Figure 33, it can be seen that
only 2 or 3 residual numbers go outside of the confidence intervals of the residual ACF or
residual PACF plots. Figure 34 shows a high R value for 1995-2013 predicted vs. measured data
with a R=0.97. Figure 35 is validation of the ARIMA (1,2,1). Figure 35 shows that MARE for
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the measured and predicted 2014 TEU data for ARIMA (1,2,1) is 3.54%. The ARIMA (1,2,1)
validation yielded the best results with the lowest MARE of 3.54%.

Figure 33. Residual ACF and PACF plot for ARIMA (1,2,1) model equation

Figure 34. Measured vs. predicted TEUs 1995-2013 ARIMA (1,2,1) model equation
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Figure 35. Validation of measured vs. predicted TEUs 2014 ARIMA (1,2,1) model equation
After comparing the ARIMA modeling, it was found that ARIMA (1,2,1) was best
because it had the lowest MARE percentage. Based on this finding, an ARIMA (1,2,1) equation
was developed. The ARIMA (1,2,1) equation can be represented by Equation 8, which was
developed by Uddin, McCullough, and Crawford [22].
▼2 * Yt = C + (1 – ϕ1B-) * (1 – θ1B) * at

(8)

Yt = Discrete time series
▼2 = Regular Differencing operator of order one
C = Constant
1 – ϕ1B = Regular AutoRegressive process of order one
1 – θ1B = Regular Moving Average process of order three
at = random shock term; normally distributed, independent with zero mean, and variance equal to
σa.
Figure 36 indicates that there was only a 0.13% difference of the predicted and measured
data from 1995-2014 and a MARE of 5.77%. This provided further validation that ARIMA
(1,2,1) is the best ARIMA model for the ports of Los Angeles and Long Beach TEU data.
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Figure 36. Measured vs. predicted TEU data for the ARIMA (1,2,1) model equation
3.1.4

Validation of ARIMA (1,2,1) and Regression Equations and Forecasting for TEU
Demand of Selected Ports
Comparing the two data results shows whether regression equation or ARIMA (1,2,1)

was a more accurate tool for data forecasting. Figure 25 is the regression model, and Figure 36
is for the ARIMA (1,2,1). The regression equation was found to have a MARE of 9.86% and a
RMSE of 115,448.67. While the regression equation is reasonable, the ARIMA (1,2,1) showed
only a 5.77% MARE value and a 72,580.24 RMSE value. Because the MARE and RMSE
values are smaller for the ARIMA (1,2,1), it is more accurate than the regression equation in
predicting and forecasting TEU demand. This shows that the ARIMA (1,2,1) should be selected
and used for future forecasting testing.
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Figure 25. Measured vs. predicted TEU data for the regression equation

Figure 36. Measured vs. predicted TEU data for the ARIMA (1,2,1) model equation
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3.2

Regression and ARIMA Analysis for TEU Demand Modeling Using California GDP as
the Independent Variable
With a very high sequential R of 0.97, monthly time as an independent variable is not

appropriate. Therefore, monthly GDP data for the state of California was found for the new
independent variable [23]. Figure 37 shows the measured monthly TEU data for the ports of Los
Angeles and Long Beach and the monthly GDP data for the state of California. As can be seen,
this data was better for the TEU data than time because California GDP also took a dip during
the economic recession. This might produce more accurate results when predicting future TEU
values.

Figure 37. California GDP vs. ports of Los Angeles and Long Beach TEUs
3.2.1

Regression Equation and Validation for 2005-2014 TEU Data using California GDP as
the Independent Variable
The regression equation was developed to determine the correlation of the 2005-2014

TEU data and California GDP data [14, 22]. Regression Equation 9 was developed. Figure 38
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was made using Equation 4 on all the TEU data, from 2005 to 2013. Figure 38 shows the
MARE value to be 9.22%. Figure 39 shows validation of Equation 9 using 2014 TEU data. The
MARE value was found to be 5.54%, which is reasonable. Figure 40 shows further validation of
Equation 9 using 2005-2014 TEU data. The MARE value was found to be 8.86%, which is
reasonable.
TEU = 924,864.161 + (0.409 x GDP)

Figure 38. Measured vs. predicted TEUs 2005-2013 (Regression Equation)

Figure 39. Validation of measured vs. predicted TEUs 2014 (Regression Equation)
47

(9)

Figure 40. Measured vs. predicted TEU data for regression equation with GDP as the
independent variable
3.3

Comparison of ARIMA (1,2,1) and Regression Equations for TEU Demand Modeling
Comparing the two data results shows whether Regression or ARIMA modeling is a

more accurate tool to use for data forecasting. Table 9 shows the comparison of ARIMA (1,2,1),
regression equation with time as the independent variable, and regression equation with
California GDP as the independent variable. Table 9 shows the percent difference for all three of
the cases. Table 9 indicates that the ARIMA (1,2,1) predicted values had a MARE value of
3.54%, the regression equation with time as the independent variable had a MARE value of
9.86%, and the regression equation with California GDP as the independent variable had a
MARE value of 8.86%. In this case, the ARIMA (1,2,1) was the best of the three cases and was
the best for predicting future values. However, unlike the regression equation, the ARIMA
(1,2,1) did not take the economic recession into account with a dummy variable. For this reason,
both methods will be used in the following section to see which is more accurate at showing
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future values. Looking at just the regression equations, it is easily seen that the use of California
GDP data as the independent variable yielded better results than did the regression equation that
used time as the independent variable. This was because the economic recession had the same
effect on California GDP and the ports of Los Angeles and Long Beach TEUs. Time is a
constant measurement and did not take the recession into account.
Table 9. Comparing ARIMA (1,2,1) and regression equations
Cumulative
Month
229
230
231
232
233
234
235
236
237
238
239
240

Month
(Observed)
Jan-14
Feb-14
Mar-14
Apr-14
May-14
Jun-14
Jul-14
Aug-14
Sep-14
Oct-14
Nov-14
Dec-14
Total
Average
SD
COV
MARE
RMSE
R Value

Total Loaded
(TEUs)

ARIMA (1,2,1)
Predictions

(TEUs)
1,214,434
1,076,959
1,152,483
1,275,880
1,288,651
1,346,954
1,300,467
1,330,785
1,404,904
1,298,692
1,244,860
1,225,804
15,160,873
1,263,406
88,510.8
7.0%

(TEUs)
1,184,840
1,185,659
1,191,770
1,215,255
1,244,670
1,277,252
1,307,033
1,329,227
1,338,614
1,330,134
1,298,667
1,239,114
15,142,234
1,261,853
59,052.7
4.7%
3.54%
52,602.04
0.79

Regression
Equation
Predictions (Time)
(TEUs)
1,332,281
1,338,198
1,344,116
1,350,034
1,355,952
1,361,870
1,367,788
1,373,706
1,379,624
1,385,542
1,391,460
1,397,378
16,377,949
1,364,829
21,337.3
1.6%
9.86%
115,448.67
0.48

Regression
Equation Predictions
(California GDP)
(TEUs)
1,232,861
1,232,861
1,232,861
1,237,411
1,237,411
1,237,411
1,242,630
1,242,630
1,242,630
1,244,054
1,244,054
1,244,054
14,870,869
1,239,239
4,633.2
0.4%
8.86%
129,301.71
0.60

3.4

Predicting TEU Demand for Future 5, 10, 15, and 20 Years Using Regression Equations

3.4.1

Predicting 5, 10, 15, and 20 Years in the Future Using Regression Equation
Regression Equation 10 will be used to predict the years of 2019, 2024, 2029, and 2034.

Regression Equation 10 is again shown below. Table 10 shows the results of 5, 10, 15, and 20
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years into the future, and Figure 41 shows a graph of the data for the predicted years using the
regression Equation 10.
TEU = 308,935.109 + (5,917.916 x Month_R) + (-403,857.290 x ER_Dummy)

(10)

Figure 41. Predicting TEU values for 5, 10, 15 and 20 years in the future using regression
equation with time as the independent variable

Figure 42. Total annual TEUs for 5, 10, 15, and 20 years in the future using regression equation
with time as the independent variable
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Figure 41 shows a steady increase for the years 2019, 2024, 2029, and 2034 from 2014.
Table 10 shows the exact percent change from the 2014 yearly averages. The yearly total of
2014 was compared to the yearly predicted totals for 2019, 2024, 2029, and 2034. According to
Table 10, the total yearly TEUs will increase by 23.3% in the first 5 years at the ports of Los
Angeles and Long Beach, and by 2034, the yearly average TEUs will increase by 53.4%.
Table 10. Average and total TEUs for predicted 5, 10, 15, and 20 years in the future
Year
2019
2024
2029
2034
Average

3.4.2

Average Monthly
% Increase from
Annual Total (TEUs)
Total (TEUs)
Annual Total in 2014
(TEUs)
1,647,904
2,000,020
2,355,095
2,713,129
2,179,037

(TEUs)
19,774,849
24,000,241
28,261,141
32,557,548
26,148,445

(TEUs)
23.3
36.8
46.4
53.4
40.0

Predicting 5, 10, 15, and 20 Years in the Future Using ARIMA (1,2,1)
As shown in Figure 43, ARIMA (1,2,1) was the most accurate of the three models tested.

This model had only a 0.10 difference between measured and predicted data. Figure 43 indicates
that the TEU data will increase the first few years before declining. The ARIMA (1,2,1) took the
recession into account, which resulted in a dip in the TEU future data about 12-14 years after
2014. Figure 44 shows the annual total TEUs for 5, 10, 15, and 20 years in the future.
According to Table 11, in the first 5 years after 2014 there will be a 3.8 total annual TEU
increase, however, in 20 years by 2034 there will be a -13.3 decrease from 2014. According to
Table 11, this will be an annual -2.0% TEU decline.
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Figure 43. Predicting TEU values for 5, 10, 15 and 20 years in the future using ARIMA (1,2,1)
modeling equation

Figure 44. Total annual TEUs for 5, 10, 15, and 20 years in the future using ARIMA (1,2,1)
model equation
Table 11. Average and total TEUs for predicted 5, 10, 15, and 20 years in the future
Year
2019
2024
2029
2034
Average

Average Monthly
% Increase from
Annual Total (TEUs)
Total (TEUs)
Annual Total in 2014
(TEUs)
1,313,696
1,306,280
1,240,010
1,114,889
1,243,719

(TEUs)
15,764,357
15,675,356
14,880,125
13,378,665
14,924,626

52

(TEUs)
3.8
3.3
-1.9
-13.3
-2.0

3.5

Summary and Recommendations
In summary, the predicted vs. measured values for ARIMA (1,2,1) had a 6.32% less

difference in MARE than the regression equation with time as the independent variable.
Therefore, the ARIMA modeling was a more effective tool. In this study, monthly data did not
work with the TEU data because there was an economic recession in 2008, causing the data to
fall drastically from the preceding year. The regression equation was able to utilize a dummy
variable to label each monthly value as either before or after the economic recession, but the
regression equation violates the sequential R requirement. Based on this study, ARIMA (1,2,1)
is the recommended method for predicting future TEU data values.
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CHAPTER IV
SPATIAL MAPPING OF SELECTED PORT INFRASTRUCTURE AND LANDUSE OF
SELECTED AREAS USING LANDSAT-8 IMAGERY

4.1

Landsat-8 Pan-sharpened Imagery Analysis for Port Infrastructure and Landuse of
Selected Areas
According to Uddin [24], “GIS database is integral to effective decision support systems

for airports, highways, roads, street networks, river resources, and other infrastructure assets
which represent areas of massive infrastructure investments.” Multispectral satellite imagery,
such as Landsat-8 imagery, is the way of the future in identifying these port infrastructures.
According to Uddin [25], “The availability of cost-competitive, high-resolution, multispectral
satellite imagery provides tremendous opportunities for analyzing infrastructure inventory, land
use/land cover and traffic volume, as well as assessing environmental and post-disaster
conditions”. Landsat-8 imagery will be used in this thesis to show port area infrastructure and
land use.
Landsat-8 imagery is multispectral satellite imagery collected every 16 days. According
to the United States Geological Survey (USGS), the satellite uses two instruments. “The
Operational Land Imager (OLI) sensor includes refined heritage bands, along with three new
bands: a deep blue band for coastal/aerosol studies, a shortwave infrared band for cirrus
detection, and a Quality Assessment band. The Thermal Infrared Sensor (TIRS) provides two
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thermal bands. These sensors both provide improved signal-to-noise radiometric (SNR)
performance quantized over a 12-bit dynamic range” [26].
Section 4.1.1 through 4.1.7 are the steps necessary to create pan-sharpened imagery.
These sections show imagery being created for the Oxford, MS area. These steps were repeated
for the ports of Los Angeles, Long Beach, and Gulfport. Section 4.1.8 will show the final
Landsat-8 pan-sharpened imagery for all of the selected areas.
4.1.1

Determining the Area of Interest (AOI) of the Oxford, MS area using Google Earth
a) Start Google Earth by double clicking on the Google Earth icon [27].
b) Under the Search box, type “Oxford, MS” as the search term, then click Search. The
AOI will be displayed on the screen in Google Earth (Figure 45).

Figure 45. Searched by Google Earth
c) Next, on the main menu, click the Add Polygon symbol, and the New Polygon dialog
box appears as shown in Figure 46.
d) Type “Oxford” as the name of the polygon, select red color and a width of 3 for lines,
and then select Outlined under Area.
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e) Draw a polygon that covers the entire Oxford area, as shown in Figure 47.

Figure 46. Defining the color and width for the AOI polygon line
f) Place the cursor to the left side of the selected area. Make four points around the
selected area and make sure to get the entire desired area inside the polygon. The
polygon made for the AOI of Oxford, MS can be seen in Figure 47. Also, show the
dimensions for the polygon made.

Figure 47. Defining color and box size of the AOI polygon
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4.1.2

Creating a map of the AOI
a) On the menu in Google Earth, click Add Place Mark, then move the yellow place
marker to one of the corners of the AOI. Then, enter the name of the corner and the
latitude coordinate and longitude coordinate of the yellow corner place marker.
b) Repeat the same steps for the other corners of the AOI.
c) Press Print Screen on the keyboard and paste the imagery made in Google Earth into
the Paint program.
d) Use the tools in the Paint program to type the coordinates for the latitude and
longitude of each corner of the map (Figure 48). The Opaque text option yields the
white background for the text.
e) Go to File>Save as>JPEG picture; then enter the name of the JPEG picture.

Figure 48. Map of the AOI-labeled polygon created in the Paint program
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4.1.3

Account Registration
a) Open Earth Explorer at website http://earthexplorer.usgs.gov/ (Figure 49).

Figure 49. Earth Explorer website
b) Click on the Register in the top right corner of the Earth Explorer website [26].
c) Enter a Username, New Password and Confirm New Password, then Click Continue.
d) Continue to complete the other required steps (Contact Demographic, Contact
Information, and Complete Registration).
e) Open the email that was used for registration, and an email from USGS will have
been received.
f) Click on the link in the email to confirm and activate the account. Note that the user
name must be remembered.

4.1.4

Searching and downloading Landsat-8 imagery of the Oxford, MS area from the USGS
website using Earth Explorer
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a) Login to USGS using your USGS registered username and password. (Figure 50)

Figure 50. Sign in USGS
b) Under Search Criteria, type the place name for which you want to download the
imagery. Type in “Oxford, MS” and then click Show.

Figure 51. Looking up Oxford, MS
c) Click on the area found. The area will be shown on the map.
d) Zoom into the Oxford, MS area being sought.
e) Click Use Map, and the map used will turn red.
f) Next, zoom out of the Oxford, MS area. The size of the rectangular box can be
changed by moving the points at the corners of the box (Figure 51).
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g) Click on Data Sets, and a list of data sets will appear. Then, click on Landsat Archive.
h) Check only Landsat-8 as shown in Figure 52.

Figure 52. Select data set window
i) Click Additional Criteria. Under Cloud Cover, select “Less than 10%” as shown in
Figure 53.

Figure 53. Additional criteria window
j) Click on Results, and note that the list of imageries covers the box made in Figure 48.
Then, select the best imagery that covers the red box (Figure 54).
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Figure 54. Search results window
k) Select the correct imagery as shown in Figure 55, then click on Metadata. This
Metadata dialog window appears in Figure 56.

Figure 55. Imagery selected
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Figure 56. Metadata information window
l) Click on the Download option seen in Figure 57. The Download option window
appears as shown in Figure 58.

Figure 57. Download option

m) Choose the “Level 1 Geo TIFF Data Product” option. This option allows the
downloading of all needed bands.

Figure 58. Download options for Landsat-8 satellite imagery
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n) Finally, extract the downloaded file to obtain all bands, as shown in Figure 59.

Figure 59. List of download bands files
4.1.5

Creating Landsat-8 multispectral imagery using ERDAS IMAGINE 2013
Landsat-8 has 11 bands, and each band has a different range of wavelength. Bands 1

through 7 and band 9 have 30m resolution. Band 8 has 15m resolution, and bands 10 and 11
have 100m resolution. The smaller the pixel size, the clearer the imagery will be.
a) Click on the symbol for ERDAS IMAGINE 2013 [28] on Desktop. The main
interface of ERDAS IMAGINE appears in Figure 60.

Figure 60. ERDAS beginning imagery
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b) From the home screen, go to Raster>Spectral>Layer Stack. The screen shown in
Figure 61 appears.

Figure 61. Open to stack and select layers
c) From the input box, as shown in Figure 61, use the selected tiff files for B1. B1 stands
for band 1. Go to the location where all the bands were saved, as seen in Figure 62.
The final input box for band 1 can be seen in Figure 63.

Figure 62. Folder location of all saved bands
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Figure 63. Input for B1
d) Repeat step c for B2, B3, B4, B5, B6, B7, and B9. Name the output folder and save it
to the folder in which the work is being performed. This is the multispectral imagery,
which should be saved as ls8_multispectral_imagery_oxford.img. The final input can
be seen in Figure 64.

Figure 64. Final window with all bands
e) Next, open the output file just created. The final output file is shown in Figure 65.
The output file takes time to create, as the bands are combined. In this case, the
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multispectral imagery took over an hour to run before it could be opened. Figure 66
shows the final multispectral imagery created in the ERDAS software.

Figure 65. Final output of multispectral imagery

Figure 66. Final Landsat-8 multispectral imagery in ERDAS
4.1.6

Creating Landsat 8 Pan-Sharpened imagery using ERDAS IMAGINE 2013
In this section, the imagery is converted from a 30m x 30m imagery and made into a 15m

x 15m imagery to give it more pixels and a higher resolution.
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a) Go to Raster>Pan-Sharpened>HPF Resolution Merge in ERDAS [28]. Once this is
completed, a window will appear. This window can be seen in Figure 67.
b) In the High Resolution box, select the B8 band from the folder containing all of the
bands, and then select the multispectral imagery already created in the multispectral
input file. The output file was named pansharpened_mul_imagery.img. This can also
be seen in Figure 67. The box beside Ignore Zero should also be checked. After this,
click OK.

Figure 67. Pan-sharpened imagery window
c) The imagery will now run to create the pan-sharpened imagery. This step will take
several hours for the computer to complete. In this case, about 4 hours was needed to
create the pan-sharpened imagery. Figure 68 shows what the screen looks like when
the imagery has been completed.
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Figure 68. Screen indicating that pan-sharpened imagery is complete
d) Now, open the pan-sharpened imagery to verify that everything worked accurately
and that there are no errors. The final pan-sharpened imagery can be seen in Figure
69.

Figure 69. Final Landsat-8 pan-sharpened imagery
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4.1.7

Creating Subset Landsat-8 pan-sharpened imagery using ERDAS IMAGINE 2013
In this section, the area from the pan-sharpened imagery for which the study is to be

performed will be selected by using the subset tool in ERDAS [28].
a) Zoom in on the area on the pan-sharpened imagery for which the study is to be
performed. The zoomed-in imagery of the Oxford, MS area can be seen in Figure 70.

Figure 70. Zooming in on Oxford, MS
b) Go to Home>Inquire>Inquire Box on the ERDAS main screen. In the box, change
the type to Lat/Lon and type in the coordinates found in Figure 48. The points box is
shown in Figure 71.

Figure 71. Inserting the Latitudes and Longitudes of Oxford, MS
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c) Now, change Lat/Lon back to Map and go to Raster>Subset & Chip>Create Subset
Imagery. The subset window appears, which is shown in Figure 72. In this window,
enter the pan-sharpened imagery in the input file and name it, then click OK. In this
case, the output file was named ls8_smaller_subset_oxford.img. Figure 73 shows the
final subset imagery made in ERDAS.

Figure 72. Subset window

Figure 73. Final subset of the Landsat-8 pan-sharpened imagery
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d) Next, be sure to export the imagery into a JPEG file. To accomplish this, go to
Manage Data>Export Data. The window for this can be seen in Figure 74.

Figure 74. Making a JPEG of the subset pan-sharpened imagery
4.1.8

Final Landsat-8 pan-sharpened imagery of the ports of Los Angeles and Long Beach, the
Port of Gulfport, and the Oxford, MS areas
This section discusses the final Landsat-8 subset pan-sharpened imageries for the selected

areas. The same procedure as set forth above was used to obtain the final results for each study
area, which is shown in Figures 75, 76, and 77. The differences between the Landsat-8
multispectral and pan-sharpened imageries were that the multispectral imageries had a pixel size
of 30m x 30m and combined bands 1, 2, 3, 4, 5, 6, 7, and 9 to create the imagery, while the pansharpened imagery had a 15m x 15m pixel size and used only band 8 combined with the
multispectral imagery to create the imagery. The Landsat-8 pan-sharpened imagery had more
and smaller pixels than the multispectral imagery, making the imagery clearer and easier to use
to identify the infrastructure and landuse.
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Figure 75. Ports of Los Angeles and Long Beach Landsat-8 pan-sharpened imagery

Figure 76. Oxford, MS Landsat-8 pan-sharpened imagery
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Figure 77. Port of Gulfport Landsat-8 pan-sharpened imagery
4.2

Infrastructure and Landuse Mapping of the Ports of Los Angeles and Long Beach, Port of
Gulfport, and the Oxford, MS Areas
In this section of the thesis, the landuse was found for the selected research areas by the

use of planimetrics in Geomedia pro [29]. The infrastructure of the area was also identified
through the use of planimetrics. Section 4.2.1 explains how the planimetrics of the Oxford, MS
area was performed using Landsat-8 imagery. This procedure was repeated for the other
research areas. Section 4.2.2 shows the final layout window of each research area’s planimetrics.
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4.2.1

Use of Geomedia pro for manual planimetrics
To start, select the Landsat-8 pan-sharpened subset imagery made of the ports of Los

Angeles and Long Beach, Port of Gulfport and Oxford, MS areas in Geomedia. In the imageries,
identify the trees, water, asphalt, concrete, and other features that can be identified manually.
The items needing to be identified can be seen in Uddin’s ENGR 597 lecture notebook [8].
Figure 78 shows the water area of the Oxford, MS area. Next, create a new area feature in
Geomedia. For water, create a new feature named “water,” as seen in Figure 79, and outline the
selected area. Now, repeat this step to identify other features within the imagery until all of the
features in the entire imagery have been identified. The snap tools should be utilized to ensure
that no space is left unidentified on the imagery. These steps will be performed for all of the
subject areas in this thesis.

Figure 78. Manual water planimetrics of the Oxford, MS area with imagery in the
background
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Figure 79. Manual water planimetics without imagery in the background
4.2.2

Final infrastructure and landuse mapping of the ports of Los Angeles and Long Beach,
Port of Gulfport, and Oxford, MS areas through the use of planimetrics
The use of planimetrics to locate the infrastructure and landuse of the research areas can

be seen in Figures 80, 81, and 82. The final planimetrics of each area will be utilized in the next
section of this thesis to compare to the calibrated BANS classification method.

Figure 80. Final planimetrics of the ports of Los Angeles and Long Beach area
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Figure 81. Final planimetrics of the port of Gulfport area

Figure 82. Final planimetrics of Oxford, MS
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4.3

Calibrated BANS Classification of Ports of Los Angeles and Long Beach, Port of
Gulfport, and Oxford, MS Areas and Comparison of Planimetrics and Calibrated BANS
Classification of the Ports of Los Angeles and Long Beach, Port of Gulfport, and Oxford,
MS Areas

4.3.1

Creating the calibrated BANS classification for the Ports of Los Angeles and Long
Beach, Port of Gulfport, and Oxford, MS Areas
Because only IKONOS Landsat-8 imagery had been used to obtain the calibrated BANS

classification by Wadajo [30], a modification to the specifications had to be made. Ratios were
found, and each type of area had to be designated. Equation 11 shows the ratio equation used for
each feature. Table 12 shows the final classifications.
Ratio for each=Landsat-8 imagery Color Band Mean / IKONOS imagery Color Band Mean (11)
Table 12. Calibrated BANS classification requirements for Geomedia

Steps

1
2
3
4
5

Decision Criteria
Vector map of built-up
area pixels
Asphalt: 4,018.50<= Green
<= 7,301.70
Building/Concrete: Step 1Step 2 Pixels
Vector map of water area
pixels
NonBuilt-up, NonWater
pixels

Polygon
map
Yes

Surface
class
legend
color
Light
Magenta

No

Grey

No

Light
Magenta

Yes

Blue

No

6

Soil: Red >= 14,254.50

No

7

NonBuilt-up, NonWater,
and NonSoil pixels

No

8

Red<= 3,900.0

No

Dark Green

9

Grass: Step 7 – 8 pixels

No

Light
Green
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Yellow

In Geomedia Pro, enter the classification for each surface. There are six different feature
areas in which classifications were made. Figures 83, 84, and 85 show the steps for the asphalt
and building/concrete features. To enter the classification for the asphalt and building/concrete,
go to the Functional Attribute tab. The window that appears can be seen in Figure 83. In this
window, input the classification. In this case, the classification reads IF[Input.B3>=4018.5 AND
Input.B3<=7301.7,”Asphalt”,”Building/Concrete”]. (Note: This will change based on the
surface that is being sought.)

Figure 83. Functional attribute window
After this is performed, the geocoded points will appear on the Geomedia screen,
although the points will not be the correct color. In this case, the asphalt needs to be changed to
grey, and the building/concrete needs to be changed to color 23. To accomplish this, go to
Thematic Maps and select Unique Value Thematic, which can be seen in Figure 84. In this
window, change the color of each point in the style box, then click OK. Figure 85 shows the
final results for the asphalt and building/concrete areas.
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Figure 84. Select the unique value thematic map

Figure 85. Final asphalt and building/concrete areas
Repeat the steps at the beginning of section 4.3 of this thesis for the remaining features.
The remaining features are water, soil, trees, and grass. The only difference will be to change
the classification for each feature and to select the appropriate color. The final calibrated BANS
classification map with all the features completed is shown in Figure 86. Repeat these steps to
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obtain the calibrated BANS classification for all three of the research areas. The final calibrated
BANS classifications made in Geomedia can be seen in Figures 86, 87, and 88.

Figure 86. Calibrated BANS classification for Oxford, MS
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Figure 87. Calibrated BANS classification for the ports of Los Angeles and Long Beach

Figure 88. Calibrated BANS classification for the port of Gulfport
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4.3.2

Comparing the planimetrics and calibrated BANS classifications of the selected research
areas
After completing the calibrated BANS classification section for all the selected areas, a

table was created for each area comparing the areas of the planimetrics and calibrated BANS
classification that were made. The planimetrics features were combined into the six features as
used by the calibrated BANS classification analysis so that the calibrated BANS classification
and planimetrics results could be compared for identifying the selected area’s landuse and
infrastructure. Tables 13, 14, and 15 show the comparisons between the planimetrics and
calibrated BANS classification for the ports of Los Angeles and Long Beach, Port of Gulfport,
and Oxford, MS areas.
Table 13. Ports of Los Angeles and Long Beach landuse differences for planimetrics and
calibrated BANS classification
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Table 14. Port of Gulfport landuse differences for planimetrics and calibrated BANS
classification

Table 15. Oxford, MS landuse differences for planimetrics and calibrated BANS classification
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In comparing the manual planimetrics data of the three areas, it can be seen that only
15.11% of the total area of Oxford, MS was built-up area. The Gulfport area had a built-up area
of 48.76%, and the Los Angeles/Long Beach area had a built-up area of 46.27%. The built-up
areas of the Gulfport and Los Angeles/ Long Beach locations would have been even larger had
the selected locations not contained a significant amount of water as part of their natural surface
areas. The data also showed that Oxford had more natural area in the manual planimetrics than
did Los Angeles/Long Beach and Gulfport. In the calibrated BANS classification for all three
study areas, only trees or grass were identified, and none of the three studies identified both trees
and grass. It appears that both the grass and tree features in each study were identified together
as either all grass or all trees. Comparing the percent difference between manual planimetrics
and calibrated BANS classification for each area was another key point. The Oxford area had
only a -0.07% difference in total built-up area and a 0.01% difference in total natural area. The
Los Angeles and Long Beach area had a -0.14% difference in total built-up area and a 0.12%
difference in total natural area. The Gulfport area had a -0.41% difference in total built-up area
and a 0.39% difference in total natural area. All three of the studies were under 1% difference in
total built-up and total natural areas. This data indicates that the studies were accurate, as they
were finding data similar to the planimetrics. The planimetrics for each of the three studies took,
on average, 100 hours longer to perform than did the calibrated BANS classification. The
calibrated BANS classification took approximately 3 hours on average for each area. This data
indicates that the calibrated BANS classification method is a more efficient and practical
method. Calibrated BANS classification is also a more efficient tool because the element of user
error is greatly reduced, as the landuse is automatically determined without the need to draw any
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polygons. The calibrated BANS results show large errors in the classifications of asphalt, grass,
and trees. This requires revision in spectral criteria.

4.4

Surface Temperature of Three Selected Study Sites
After finding the areas’ landuse by calibrated BANS classification, a weighted typical hot

summer day temperature was analyzed for the following three study sites.
Site 1: Ports of Los Angeles and Long Beach, CA
Site 2: Port of Gulfport, MS
Site 3: Oxford, MS
According to Boriboonsomin and Uddin, “Increased surface temperature, due to built-up
areas produces heat-island effect, which is known to influence O3 [Ozone] level” [31]. The
purpose of this analysis was to use the landuse data found by the calibrated BANS classification,
including the built-up areas, to find the average weighted surface temperatures for the study sites.
First, the surface class temperatures on a typical summer day at air temperature, which
can be observed in Figure 89, were reported by Boriboonsomin and Uddin [31]. This analysis
was conducted for a typical summer day when the air temperature is 27.2 °C [31]. As shown in
this figure, each of the six surface classes had a different value for surface temperature: asphalt is
64.9 degrees Celsius (°C), building/concrete is 57.2 °C, dry soil is 56.9 °C, wet soil is 47.7 °C,
grass is 46.8 °C, tree/wooded area is 45.3 °C, and water is 34.4 °C. These surface temperatures
were used to find an average weighted temperature for each surface area in the three study sites.
Next, the calibrated BANS classification data was used for each of the three sites. This data can
be found in Tables 13, 14, and 15 from earlier in this thesis. After this, the surface temperatures
and calibrated BANS classification feature percentages were multiplied together for each site.
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The final step was to sum up all of the temperatures found for each feature to determine the final
average weighted temperature of the sites. Tables 16, 17, and 18 show the data which was used
for these computations. Figure 90 shows the average weighted temperatures found for each of
the three study sites. The ports of Los Angeles and Long Beach site had an average weighted
temperature of 45.94 °C, the port of Gulfport site had an average weighted temperature of 50.72
°C, and the Oxford site had an average weighted temperature of 47.16 °C. The ports of Los
Angeles and Long Beach site had the largest building/concrete area and the most water area.
This water area caused the ports of Los Angeles and Long Beach site to have the lowest average
weighted temperature. The port of Gulfport site had the highest average weighted temperature
because it had the highest percentage of asphalt.

Figure 89. Surface temperatures by landuse feature
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Table 16. Average weighted temperature of the ports of Los Angeles and Long Beach site

Ports of Los Angeles and Long Beach Site
Surface Class

Surface Temperature (°C)

Building/Concrete
Asphalt
Water
Soil
Tree/Wooded Area
Grass

57.2
64.9
34.4
56.9
45.3
46.8

Calibrated BANS
Classification
Feature
Percentage
38.10%
8.10%
50.70%
0.00%
0.00%
3.10%

Average Weighted
Temperature

Temperature
(°C)
21.79
5.26
17.44
0.00
0.00
1.45
45.94

Table 17. Average weighted temperature of the port of Gulfport site

Port of Gulfport Site
Surface Class

Surface Temperature (°C)

Building/Concrete
Asphalt
Water
Soil
Tree/Wooded Area
Grass

57.2
64.9
34.4
56.9
45.3
46.8

Average Weighted
Temperature

Calibrated BANS
Classification
Temperature
Feature
(°C)
Percentage
23.80%
13.61
24.76%
16.07
24.90%
8.57
0.53%
0.30
0.00%
0.00
26.01%
12.17
50.72
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Table 18. Average weighted temperature of the Oxford, MS site

Oxford, MS Site
Surface Class

Surface Temperature (°C)

Building/Concrete
Asphalt
Water
Soil
Tree/Wooded Area
Grass

57.2
64.9
34.4
56.9
45.3
46.8

Average Weighted
Temperature

Calibrated BANS
Classification
Temperature
Feature
(°C)
Percentage
15.09%
8.63
0.00%
0.00
0.86%
0.30
1.37%
0.78
82.67%
37.45
0.00%
0.00
47.16

Figure 90. Average weighted surface temperature for selected study sites
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4.5

Comparing the Population Density for the Cities of Oxford, MS, Los Angeles, CA, and
Gulfport, MS Areas
This section of the thesis focuses on finding and comparing the population densities for

the Cities of Oxford, MS, Los Angeles, CA, and Gulfport, MS. Unlike section 4.3.2, in which
the cities and their surrounding areas were compared, this section will compare the population
densities for the city areas only. This was done to make a comparison of the three city areas as a
whole and to provide an understanding of why one area may be more built-up or less built-up
than another. Figure 91 shows the Oxford, MS city boundary area. Figure 91 was created to
find the square miles for the area. Next, the population for Oxford, MS was determined [32].
Then, Equation 12 was used to calculate the population density of the area. These steps were
repeated for the cities of Gulfport, MS and Los Angeles, CA. Table 19 below shows the final
results obtained for all three cities.

Figure 91. Oxford, MS city limits
Population Density = City Population / City Land Area
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(12)

Table 19. Population density comparison of the three selected areas
Population

Land Area

Population Density

(Square Miles)

(People/Square Mile)

City of Oxford, MS

20,865

10.75

1,941

City of Los Angeles, CA

3,884,000

503.00

7,722

City of Gulfport, MS

71,012

64.21

1,106

As shown in Table 19, the City of Los Angeles, CA had the highest population density
with 7,722 people per square mile. Although the City of Gulfport had more than three times as
many people as the City of Oxford, Oxford had over 800 more people per square mile than
Gulfport.
4.6

Recommended Applications for Imagery Analysis
It is recommended that a revised BANS classification be developed using Landsat-8

imagery to improve accuracy. This revised L-BANS method should be used for mapping a port
area’s current infrastructure and landuse, to provide useful information for evaluating the present
conditions of the area and to assist in planning for improvements.
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CHAPTER V
SPATIAL MAPPING OF CARGO VESSELS AND ASSOCIATE EMISSION IMPACTS
This chapter will discuss case studies of spatial mapping of cargo vessels through vessel
counts. CO2 emissions data was also developed through a case study of a sample cargo vessel
route across the Atlantic Ocean.
5.1

AIS Cargo Vessel Data Analysis of Spatial Mapping
In this section, five locations were studied around the U.S. and Europe to make analysis

of the number of cargo vessels present in these locations hourly. A website was used to count
the vessels within the selected areas [33]. Figure 92 shows the five selected locations in which
the cargo vessels counts were taken. The five locations selected were West Pacific Alaska [W],
Pacific Ocean [P], Gulf/Caribbean [G], U.S. East Coast Atlantic [EA], and Europe Atlantic [E].
Figure 93 is a screen shot of one of the five locations on the website and is an example of the
number which were counted hourly [33]. The five different locations are spaced out to observe
vessel data in different areas. Four of the areas are located in U.S. shipping area and the fifth
area is of the European shipping area between Europe and the U.S. east coast. This will show
most of the daily flow of cargo shipping vessels around the U.S. coast lines.
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Figure 92. Study locations selected

Figure 93. Locations of selected vessel counts on the website map [33]
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An analysis of each of the five locations was performed in this thesis. To make these
analyses, cargo vessels were counted on Monday, September 7, 2015, at 12:00 AM, 1:00 AM,
5:00 AM, 6:00 AM, 12:00 PM, 1:00 PM, 5:00 PM, and 6:00 PM CST. These times were
selected to establish how the vessel count would change throughout the day. Interpolation and
extrapolation were used to determine the number of vessels present between the hours the counts
were made. This was done to determine the 24-hour daily average of the five locations. Figures
94, 95, 96, 97, and 98 and Tables 20, 21, 22, 23, and 24 show the vessel counts for each of the
five locations. The figures also show the percentage of the maximum cargo vessel count for
each individual hour count. Equation 13 was used to make these calculations. These
calculations were necessary because every vessel did not leave the area prior to the next hour’s
count, and the numbers derived from these calculations assisted in establishing the number of
cargo vessels leaving and entering the particular location each hour.
100

Percentage of maximum cargo vessel count =
Table 20. Data from the West Pacific Alaska [W] location
West Pacific Alaska [W]
1

2

3

3= 1 or 2/(largest value in
1)*100

Orginal Vessel
Count Data

Adjusted Data for Missing
Cells by
Interpolation/Extrapolation

Cargo Vessel Count
Data Per Hour

Percent Change Normalized
to Maximum Value Count

12:00 AM

103

103

100.0%

1:00 AM

102

102

99.0%

2:00 AM

99

99

96.1%

3:00 AM

96

96

93.2%

4:00 AM

93

93

90.3%

90

87.4%

5:00 AM

90

6:00 AM

92

92

89.3%

7:00 AM

93

93

90.3%

8:00 AM

94

94

91.3%

9:00 AM

95

95

92.2%

10:00 AM

96

96

93.2%

11:00 AM

97

97

94.2%

12:00 PM

98

98

95.1%

1:00 PM

100

100

97.1%

2:00 PM

99

99

96.3%

3:00 PM

98

98

95.5%

4:00 PM

98

98

94.8%

97

94.2%

5:00 PM

97

6:00 PM

96

96

93.2%

7:00 PM

94

94

91.3%

8:00 PM

82

92

89.3%

9:00 PM

90

90

87.4%

10:00 PM

88

88

85.4%

11:00 PM

86

86

83.5%

12:00 AM

84

84

81.6%

93

95

Average

97

93

(13)

Figure 94. West Pacific Alaska [W] vessel counts and percentage of maximum vessel count
Figure 94 and Table 20 show the hourly cargo vessel counts for the West Pacific Alaska
[W] location. This location had between 84-103 cargo vessels each hour during the 24-hour
count period. The average 24-hour cargo vessel count for this location was 95 vessels. The low
cargo vessel count of 84 occurred at 12:00 AM CST on September 8, 2015, and the maximum
cargo vessel count of 103 occurred at 12:00 AM CST on September 7, 2015. The lowest
percentage of the maximum vessel count value in this location was 81.6%. This represented a
large percentage of the maximum value, which may indicate that few vessels entered and exited
this location on this day.
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Table 21. Data from the Pacific Ocean [P] location
Pacific Ocean [P]
1

2

3

3= 1 or 2/(largest value in
1)*100

Orginal Vessel
Count Data

Adjusted Data for Missing
Cells by
Interpolation/Extrapolation

Cargo Vessel Count
Data Per Hour

Percent Change Normalized to
Maximum Value Count
92.4%

12:00 AM

194

194

1:00 AM

189

189

90.0%

2:00 AM

191

191

90.7%

3:00 AM

192

192

91.4%

4:00 AM

194

194

92.1%
92.9%

5:00 AM

195

195

6:00 AM

194

194

92.4%

7:00 AM

195

195

92.7%

8:00 AM

195

195

93.0%

9:00 AM

196

196

93.3%

10:00 AM

197

197

93.6%

197

11:00 AM

197

94.0%

12:00 PM

198

198

94.3%

1:00 PM

203

203

96.7%

2:00 PM

205

205

97.5%

3:00 PM

207

207

98.3%

4:00 PM

208

208

99.2%

210

100.0%

5:00 PM

210

6:00 PM

208

208

99.0%

7:00 PM

206

206

98.1%

8:00 PM

204

204

97.1%

9:00 PM

202

202

96.2%

10:00 PM

200

200

95.2%

11:00 PM

198

198

94.3%

12:00 AM

196

196

93.3%

199

199

Average

199

Figure 95. Pacific Ocean [P] vessel counts and percentage of maximum vessel count
95

Figure 95 and Table 21 show the hourly cargo vessel counts for the Pacific Ocean [P]
location. This location had between 189-210 cargo vessels each hour during the 24-hour count
period. The average 24-hour cargo vessel count for this location was 199 vessels. The low
cargo vessel count of 189 occurred at 1:00 AM CST on September 7, 2015, and the maximum
cargo vessel count of 210 occurred at 5:00 PM CST on September 7, 2015. The lowest
percentage of the maximum vessel count value in this location was 90.0%. This represented a
large percentage of the maximum value, which may indicate that few vessels entered and exited
this location on this day.
Table 22. Data from the Gulf/Caribbean [G] location
Gulf/Caribbean [G]
1

2

3

3= 1 or 2/(largest value in
1)*100

Orginal Vessel
Count Data

Adjusted Data for Missing
Cells by
Interpolation/Extrapolation

Cargo Vessel Count
Data Per Hour

Percent Change Normalized
to Maximum Value Count

12:00 AM

405

405

78.8%

1:00 AM

404

404

78.6%

2:00 AM

410

410

79.7%

3:00 AM

416

416

80.8%

4:00 AM

421

421

82.0%
83.1%

5:00 AM

427

427

6:00 AM

431

431

83.9%

7:00 AM

438

438

85.2%

8:00 AM

445

445

86.5%

9:00 AM

452

452

87.8%

10:00 AM

458

458

89.2%

11:00 AM

465

465

90.5%

472

91.8%

12:00 PM

472

1:00 PM

465

465

90.5%

2:00 PM

467

467

90.8%

3:00 PM

469

469

91.1%

4:00 PM

470

470

91.4%
91.8%

5:00 PM

472

472

6:00 PM

478

478

93.0%

7:00 PM

484

484

94.2%

8:00 PM

490

490

95.3%

9:00 PM

496

496

96.5%

10:00 PM

502

502

97.7%

11:00 PM

508

508

98.8%

12:00 AM

514

514

100.0%

465

458

Average

444
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Figure 96. Gulf/Caribbean [G] vessel counts and percentage of maximum vessel count
Figure 96 and Table 22 show the hourly cargo vessel counts for the Gulf/Caribbean [G]
location. This location had between 404-514 cargo vessels each hour during the 24-hour count
period. The average 24-hour cargo vessel count for this location was 458 vessels. The low
cargo vessel count of 404 occurred at 1:00 AM CST on September 7, 2015 , and the maximum
cargo vessel count of 514 occurred at 12:00 AM CST on September 8, 2015. The reason for
these cargo vessel count results may have been that September 7, 2015, was Memorial Day, and
businesses may have been closed until September 8, 2015. The lowest percentage of the
maximum vessel count value in this location was 78.8%. Over 20% of the maximum value had
exited the location at 1:00 AM, indicating that the vessels were active on this day at this location.
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Table 23. Data from the East Coast Atlantic [EA] location
East Coast Atlantic [EA]
1

2

3

3= 1 or 2/(largest value in
1)*100

Orginal Vessel
Count Data

Adjusted Data for Missing
Cells by
Interpolation/Extrapolation

Cargo Vessel Count
Data Per Hour

Percent Change Normalized
to Maximum Value Count

12:00 AM

230

230

94.3%

1:00 AM

229

229

93.9%

2:00 AM

230

230

94.2%

3:00 AM

231

231

94.5%

4:00 AM

231

231

94.8%
95.1%

5:00 AM

232

232

6:00 AM

229

229

93.9%

7:00 AM

227

227

92.8%

8:00 AM

224

224

91.8%

9:00 AM

222

222

90.8%

10:00 AM

219

219

89.8%

11:00 AM

217

217

88.7%

214

87.7%

12:00 PM

214

1:00 PM

209

209

85.7%

2:00 PM

210

210

86.2%

3:00 PM

212

212

86.7%

4:00 PM

213

213

87.2%

5:00 PM

215

215

88.1%

6:00 PM

220

220

90.2%

7:00 PM

224

224

91.8%

8:00 PM

228

228

93.4%

9:00 PM

232

232

95.1%

10:00 PM

236

236

96.7%

11:00 PM

240

240

98.4%

12:00 AM

244

244

100.0%

226

225

Average

222

Figure 97. East Coast Atlantic [EA] vessel counts and percentage of maximum vessel count
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Figure 97 and Table 23 show the hourly cargo vessel counts for the East Coast Atlantic
[EA] location. The average 24-hour cargo vessel count for this location was 225 vessels. The
low cargo vessel count of 209 occurred at 1:00 PM CST on September 7, 2015, and the
maximum cargo vessel count of 244 occurred at 12:00 AM CST on September 8, 2015. The
reason for these cargo vessel count results may have been that September 7, 2015, was Memorial
Day, and businesses may have been closed until September 8, 2015. The lowest percentage of
the maximum vessel count value in this location was 85.7%.
Table 24 shows the results of hourly vessel counts for a 24-hour period for E route. The
average hourly vessels count is 5,847 per day.
Table 24. Data from the Europe Atlantic [E] location
Europe Atlantic [E]
1

2

3

Orginal Vessel
Count Data

Adjusted Data for Missing
Cells by
Interpolation/Extrapolation

3= 1 or 2/(largest value in
1)*100

Cargo Vessel Count Percent Change Normalized
Data Per Hour
to Maximum Value Count

12:00 AM

5,741

5,741

94.5%

1:00 AM

5,803

5,803

95.5%

2:00 AM

5,870

5,870

96.6%

3:00 AM

5,937

5,937

97.7%

4:00 AM

6,004

6,004

98.8%

5:00 AM

6,071

6,071

99.9%

6:00 AM

6,077

6,077

100.0%

7:00 AM

6,070

6,070

99.9%

8:00 AM

6,064

6,064

99.8%

9:00 AM

6,057

6,057

99.7%

10:00 AM

6,050

6,050

99.6%

11:00 AM

6,044

6,044

99.5%

12:00 PM

6,037

6,037

99.3%

1:00 PM

6,029

6,029

99.2%

2:00 PM

5,954

5,954

98.0%

3:00 PM

5,879

5,879

96.7%

4:00 PM

5,804

5,804

95.5%
94.3%

5:00 PM

5,729

5,729

6:00 PM

5,703

5,703

93.8%

7:00 PM

5,657

5,657

93.1%

8:00 PM

5,611

5,611

92.3%

9:00 PM

5,565

5,565

91.6%

10:00 PM

5,519

5,519

90.8%

11:00 PM

5,473

5,473

90.1%

12:00 AM

5,427

5,427

89.3%

5,823

5,847

Average

5,899
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Figure 98. Europe Atlantic [E] vessel counts and percentage of maximum vessel count
Figure 98 and Table 24 show the hourly cargo vessel counts for the Europe Atlantic [E]
location. This location had between 5,427-6,077 cargo vessels each hour during the 24-hour
count period. The average 24-hour cargo vessel count for this location was 95 vessels. The low
cargo vessel count of 5,427 occurred at 12:00 AM CST on September 8, 2015, and the maximum
cargo vessel count of 6,077 occurred at 6:00 AM CST on September 7, 2015. The lowest
percentage of the maximum vessel count value in this location was 89.3%. With only 11.7% of
the maximum value exiting the location, this location retained a large number of vessels
throughout the day.
The data showed that the Pacific Ocean location had 90% of the maximum count in the
location for the entire 24 hours, the highest percentage among the study locations. The Europe
location had an average of 5,427 cargo vessels per hour in this location, the highest among the
study locations. The Gulf/Caribbean location had the second highest per hour average, with an
average of 458 cargo vessels per hour. Figure 99 provides a comparison between the 5 regions.
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Figure 99. Comparison of the five selected shipping locations
5.2

Shipping Emissions Analysis and Impacts
A study on CO2 emissions data was calculated using a sample cargo vessel trip. The

study was made for a 12,000 TEU cargo vessel for an assumed trip from the Port of New York to
the Port de Honfleur in France. This shipping route and distance may be seen in Figure 100.
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Figure 100. Shipping route between Port of New York and Port de Honfleur in France
The distance of the trip was 6,001 kilometers [27]. It was known that a cargo vessel
emits 22.2 lbs. of CO2 per gallon when traveling [34]. It was also known that a 12,000 TEU
cargo vessel consumes 125 gallons of gas per mile [35]. Equation 14 was used to calculate the
number of miles per gallon (MPG) a 12,000 TEU cargo vessel achieves [35]. Equation 15 was
used to convert kilometers to miles [36]. Equation 16 was created by Uddin [37]. This equation
was used to calculate the CO2 emissions for the trip.
MPG of a 12,000 TEU cargo vessel = 1 mile / 125 gallons = .008 mpg

(14)

Trip Distance = 6001 km x .621371 miles/km = 3,728.85 miles

(15)

CO2 Emissions = (miles / vehicle fuel efficiency) x pounds of CO2 emitted per gallon

(16)
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CO2 Emissions = (3,728.85 miles / 0.008 mpg) x 22.2 pounds of CO2 = 10,347,559 lbs. of CO2
As shown by this example, a trip from the Port of New York to the Port de Honfleur in
France may result in the release of 10,347,559 lbs. or 5,174 short tons of CO2 per trip. This is
only for one single trip. With this in mind, steps need to be taken now to reduce CO2 emissions,
such as bigger sized ships.
5.3

Emission Impacts of Port Infrastructure and Inland Cargo Distribution
The impacts of the emission of pollutants may be divided into three categories: direct

impacts, which include “the immediate consequence of transport activities” from emissions;
indirect impacts, which include “the secondary (or tertiary) effects of transport activities on
environmental systems,” such as respiratory and cardiovascual problems; and cumulative
impacts, which include “the additive, multiplicative or synergetic consequences of transport
activities,” [38].
The mode of transportation used to ship cargo can have an effect on emissions. As
shown in Figure 1, shipping one ton of cargo one kilometer by container ships and rail produce
the lowest number of grams of CO2 [6].
5.4

Recommended Applications
The AIS data on commercial websites are already being used to monitor shipping traffic

and to help enhance safety. The use of AIS data in this research showed that a reasonable
estimate of global shipping traffic can be made for selected navigation routes. This shipping
traffic analysis can be further used to estimate CO2 emissions.

103

CHAPTER VI
SUMMARY, CONCLUSIONS, AND RECOMMENDATIONS
6.1

Summary of Research Accomplished
The import and export of goods is a major part of the U.S. economy, and the volume of

cargo handled by U.S. ports is expected to increase in the future as population increases. U.S.
ports must make plans now to accommodate this expected growth in volume, as every U.S. state
would be adversely affected if improvements are not made to the capacity, infrastructure, and
efficiency of U.S. ports. Due to this expected growth in volume and increase in shipping, ports
must also address the need for alternative, more efficient shipping routes for cargo vessels and
take steps to alleviate the expected increase in CO2 emissions.
A major West Coast port area, the adjoining ports of Los Angeles and Long Beach,
California, was selected for case study. An initial study was made to determine where the goods
from the study area were distributed throughout the U.S. A statistical demand prediction model
for the study area was developed based on TEU data, and TEU data predictions were made for 5,
10, 15, and 20 years into the future using ARIMA (1,2,1) and the regression equation with year
and dummy variable as the independent variables. Spatial maps of infrastructure and landuse
were developed using pan-sharpened Landsat-8 imagery for the study area and for two other
selected areas. The accuracy and efficiency of the BANS classification of infrastructure and
landuse was evaluated by comparing with the manual planimetrics. AIS data was developed
through ship counts. CO2 emissions data was calculated using a sample cargo vessel trip.
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6.2

Conclusions
Key findings for the cargo demand portion of this thesis are as follows:


Of the three major port regions in the U.S., container liner service ports in the East
Coast region handled the most tons annually at 39.83% of the total 2010 U.S. freight.



The state that handled the most freight in the West Coast region in 2010 was
California, which was only one of three states with container liner service ports that
handled over 90 million tons of freight in 2010.



The ports of Los Angeles and Long Beach distribute 89.0% of their total imports to
destinations in California. The top five U.S. states to which the ports of Los Angeles
and Long Beach distributed their goods were California, Arizona, Nevada, Texas, and
Washington.



Linear optimization analysis was performed on import freight of 66.76 million tons
shipped from the ports of Los Angeles and Long Beach to destinations in California,
Arizona, Nevada, Texas, and Washington. This analysis showed that shipping costs
were reduced by 27.4% by diverting 30% of the freight from road to rail.

Key findings for TEU prediction modeling are as follows:


Regression equations with time as the independent variable and with California GDP
as the independent variables were compared to ARIMA (1,2,1) to determine which of
these was the better method to predict future TEU values. ARIMA (1,2,1) was
determined to be the better method with a lower MARE value of 5.34% and a lower
RMSE value of 52,602.04.
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Using a dummy regression equation with year and dummy variable for the 2008
economic recession as the independent variables, the ports will have 36.8% more
TEUs coming through the ports in 10 years. However, because the original data
included an economic recession about 13 years into the measured TEU data, the
ARIMA (1,2,1) found an increase of 3.3% in the next 10 years and a decrease of
13.3% in the next 20 years. The 2015 TEU data showed a 0.01% increase from the
2014 TEU data. This is supportive of ARIMA (1,2,1) because it predicted a 3.3%
increase in the next 10 years and a 13.3% decrease in 20 years.

Key findings for the spatial mapping portion of this thesis are as follows:


Landsat-8 pan-sharpened imagery was analyzed for the selected study sites. For the
ports of Los Angeles and Long Beach, the planimetrics analysis revealed that this
area had little in the way of trees, grass, and soil and much larger areas of water and
building/concrete in its imagery. The calibrated BANS classification generally
yielded the same results as the planimetrics. The most notable difference was that the
calibrated BANS classification did not identify any trees or soil. The difference
between the planimetrics and calibrated BANS classification for the built-up area was
-0.14% and for the natural area was 0.12%.



For the Port of Gulfport, the planimetrics analysis revealed that the area had a larger
portion of trees and grass than the ports of Los Angeles and Long Beach, although
Gulfport still had a fair amount of building/concrete. The calibrated BANS
classification yielded nearly the same results as the planimetrics. The most notable
difference was that the calibrated BANS classification did not identify any trees. The
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difference between the planimetrics and calibrated BANS classification for the builtup area was -0.41% and for the natural area was 0.39%.


For the Oxford, MS area, the planimetrics analysis revealed that the area had a large
proportion of trees and grass. The calibrated BANS classification yielded generally
the same results as the planimetrics. The most notable difference was the calibrated
BANS classification did not identify any trees or asphalt. The difference between the
planimetrics and calibrated BANS classification for the built-up area was -0.07% and
for the natural area was 0.01%.



In each study, not all results of the calibrated BANS classification were similar to
those obtained through the use of manual planimetrics, but the calibrated BANS
classification analysis took much less time to perform than planimetrics. The
calibrated BANS classification is not subjective nor manual. It is an efficient method
for mapping infrastructure and landuse. It is not reasonably accurate at classifying
asphalt, grass, and trees. It is recommended to develop a new L-BANS surface
classification using Landsat-8 spectral data.

Key findings for the spatial mapping of cargo vessels and associate emissions impacts
portion of this thesis are as follows:


Based on a 24-hour vessel count performed on five selected navigation routes, the
West of Europe’s coast had the most vessels at an average of 5,847 cargo vessels per
hour in the 24-hour period. The top region in the U.S. was the Gulf/Caribbean with
an average of 458 cargo vessels per hour in the 24-hour period.
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Based on an analysis of a sample cargo vessel route from the Port of New York to the
Port de Honfleur in France, it was found that one 12,000 TEU vessel could emit
10,347,559 lbs. or 5,174 short tons of CO2 during this trip.

6.3

Recommendations


It is recommended that more studies be performed on the distribution of commodities
from U.S. ports to destinations in the U.S. in order to improve the efficiency of the
overall shipping process and to optimize shipping costs.



It is recommended that individual ports develop demand prediction models for future
years using ARIMA modeling, so that they may plan for and make infrastructure and
other improvements as needed to accommodate the expected increases in future cargo
volume.



It is recommended that a new L-BANS classification method be developed using
Landsat-8 spectral data that can be used for mapping a port area’s current
infrastructure and landuse to provide useful information for evaluating the present
conditions of the area and to assist in planning for improvements.



It is recommended that data obtained by AIS be used as a tool for shipping flow
analysis to assist in estimating shipping demand and to improve shipping efficiency
and routing.



It is recommended that steps be taken to reduce CO2 emissions in shipping, especially
in light of the expected increase in the volume of shipping in the future.
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Optimization Analysis of Cargo Shipping Distribution and Results
Linear optimization was performed for the ports of Los Angeles and Long Beach
distribution data. The linear optimization was chosen because the process takes “various linear
inequalities and finds the ‘best’ value obtainable under those conditions” [41]. In this case, the
value sought will be the minimum value. Two different scenarios were analyzed. The first
scenario involved shipping 100% of the freight from the ports of Los Angeles and Long Beach to
selected state markets by truck. The second scenario involved shipping 70% of the freight by
truck and shipping 30% of the freight by rail.
The following Equation 1 is used to calculate bij.
bij = (Distance from port to state market x (unit cost/100))

(1)

= Unit cost per ton-mile of shipping one unit of freight from port (i) to state (j)
The first step in solving the linear optimization problem is creating an objective function.
The objective function is as follows (Equation 2):
Minimize: Z = ∑

∑

(2)

Z= Total cost (U.S.$) to ship from port (i) to each state market (j), where i=1,…I and j=1,2,3,…J
= Quantity of the freight tonnage shipped from port (i) to state market (j)
= Unit cost per ton-mile for freight shipping from port (i) to state market (j)
(This basic unit cost for freight truck is 42.38 cents per ton-mile and the freight rail unit cost
is 3.70 cents per ton-mile.)
dij= distance from port to market = 364.0 miles to California market (j), 355.9 miles to Arizona
market (j), 243.6 miles to Nevada market (j), 1,241.7 miles to Texas market (j), and 981.3 miles
to Washington market (j)

117

The first constraint deals with the summing of all commodity freight shipped from the
port location to all selected state markets, which cannot exceed the total commodity freight
available at the port (Equation 3).

∑

yij ≥ -T

(3)

T= Total freight available at port, where i=1,…I and j=1,2,3,…J
The second constraint deals with the total amount sent to a state market, which cannot be
less than the amount of the commodity required in that state market as shown in Equation 4.
Additionally, the amount of freight from port to state market must be a positive value as shown
in Equation 5. The input data for the unit ton cost for both scenarios is shown in Tables A1 and
A2.
∑

yij ≥ rj

(4)

rj= Freight required at each port (i) for the state market (j), where i=1,…I and j=1,2,3,…J
yij ≥ 0
= Quantity of the freight tonnage shipped from port (i) to state market (j),
where i=1,..I and j=1,2,3,..J
Table A1. Unit cost per ton (Base Scenario 100% Road)
Linear Distance from the Ports to Each State Market and Unit Cost per Ton
Distance
U.S. Dollars Per Ton
Ports (i)
State Markets (j)
(Miles)
Distances x (42.38/100)
California, CA
364.0
$154.24
Ports of Los
Arizona, AZ
355.9
$150.81
Angeles and
Nevada, NV
243.6
$103.22
Long Beach
Texas, TX
1,241.7
$526.24
Washington, WA
981.3
$415.87
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(5)

Table A2. Unit cost per ton (Alternative Scenario 70% Road, 30% Rail)
Linear Distance from the Ports to Each State Market and Unit Cost Per Ton
Distance
U.S. Dollars Per Ton
Ports (i)
State Markets (j)
(Miles)
Distances x (30.78/100)
California, CA
364.0
$112.02
Arizona,
AZ
355.9
$109.53
Ports of Los
Angeles and
Nevada, NV
243.6
$74.97
Long Beach
Texas, TX
1,241.7
$382.20
Washington, WA
981.3
$302.04

Step by Step Excel Solver Procedure
1) The first step is to set up Solver in Excel. To accomplish this, click on File in the top left
corner, and click on Options. Figure A1 will appear.

Figure A1. Excel Options menu
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2) Next, go to the Customize Ribbon tab. Once there, select Developer under the main tabs.
This can be seen in Figure A2. After clicking Developer, click OK.

Figure A2. Selecting Developer under Customized Ribbon option
3) After selecting Developer, go to the top of the page and select Developer and click on the
Add-Ins tab, and the page shown in Figure A3 will appear. Select Solver Add-In as shown in
Figure A3. The Solver tab will be added in the Data tab as shown in Figure A4.
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Figure A3. Selecting Solver Add-In tool for optimization

Figure A4. Solver tab in Microsoft Excel
4) The next step is to input the data, which in this case is the unit price and freight tons for each
selected market. Constraints are also set up to be read in Excel Solver. Table A3 and Table A4
show how it appears before using Solver. The objective function can be seen in Table A5 and
Equation 6. The freight million ton numbers 62.51, 1.44, 1.42, 0.83, and 0.56 were found from a
commodity flow data analysis study [11].
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Table A3. Setting up data to run Excel Solver (Base Scenario of 100% Truck)

Table A4. Setting up data to run Excel Solver (Alternative Scenario 70% Truck and 30% Rail)

Table A5. Objective function being used in Excel
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= C3*C4 + D3*D4 + E3*E4 + F3*F4 + G3*G4

(6)

Equation 6 is the objective function needed to run Solver. C3, D3, E3, F3, and G3 are the
yij values from each port (i) to state market (j), and C4, D4, E4, F4, and G4 are the bij values or
unit cost per ton-mile in US$ from each port (i) to state market (j).
5) Next, enter the data and constraints into Excel Solver. Click on Solver, and the image shown
in Figure A4 will appear. Then click Add to add the constraints. Figure A5 shows the box that
appears when Add is selected. Next, insert all constraints, clicking the Add button each time one
is completed. In the By Changing Variable Cells field, insert the freight tons shipped to each
market. The next step is to input the set objective number and to change the Select a Solving
Method to Simplex LP. The final data in Solver before solving can be seen in Figure A6.

Figure A4. Solver parameters
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Figure A5. Adding Constraints

Figure A6. Final Solver parameters before solving the linear optimization problem
The freight million ton numbers 62.51, 1.44, 1.42, 0.83, and 0.56 were found from a
commodity flow data analysis study [11].
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6) The next step is to click Solve, and Figure A7 will appear. Click on Answer, Sensitivity, and
Limits to obtain the results. After selecting these, click OK.

Figure A7. Solver results options

7) Finally, analyze the results from Solver. The Answer Report sheet tab will show the final
minimum value results, as shown in Table A6. As shown in Table A6, the final minimum cost
for 100% freight shipped by truck is $10,675 million U.S. dollars or $10.7 billion U.S. dollars.
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Table A6. Final answer for optimized minimum cost value for base scenario

In conclusion, linear optimization found the lowest minimum value to ship freight by
100% truck, and by 70% truck and 30% rail. This process showed that shifting some of the
freight to rail would substantially lower the cost of shipping.
The final results for the two scenarios are shown in Tables A7 and A8. It was observed
that a 27.4% decrease in minimum cost occurred when 30% of the truck freight was diverted to
rail.
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Table A7. Optimized minimum transportation costs for freight shipping
100% by road (base scenario)

Base Scenario
(100% Truck)

Ports of Los Angeles and Long Beach
Freight Available: 66.76 million tons
a

b

CA
AZ
Unit Cost Per Ton $154.24 $150.81
Freight Million
62.51
1.44
Tons (Distributed)

Z

c

d

e

NV
$103.22

TX
$526.24

WA
$415.87

1.42

0.83

0.56

(Millions U.S.
Dollars)

$10,675.09

Table A8. Optimized minimum transportation costs for freight shipping
70% by road and 30% by rail (alternative scenario)
Alternative
Scenario
(70 % Truck and
30% Rail)
Unit Cost Per Ton
Freight Million
Tons (Distributed)

Ports of Los Angeles and Long Beach
Freight Available: 66.76 million tons
a

b

c

d

Z
e

(Millions U.S.
Dollars)

CA
AZ
NV
TX
WA
$112.02 $109.53 $74.97 $382.20 $302.04
62.51

1.44

1.42
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0.83

0.56

$7,753.16
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